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Chapter 1
Introduction

Congratulations on your purchase of the Canon BJ-200ex
Bubble Jet Printer. We appreciate your choosing this
printer to meet your printing needs.

The BJ-200ex offers excellent print quality, fast print
speed, and trouble-free operation with the convenience of
compact size and low cost. We are certain you will be
satisfied with its advanced bubble jet technology.

This chapter introduces you to the features of your new
printer, lists the options and supplies you can purchase for
the printer, and describes Canon's customer support
procedures.

Features and Benefits
The BJ-200ex Bubble Jet Printer produces high quality
printing by incorporating many useful features.

Excellent Print Quality
The printer's high performance print head offers 720
(horizontal) by 300 (vertical) dots per inch (dpi) for high
resolution text and graphics. The printer produces excellent
grayscale quality when using Microsoft® Windows™
graphics applications through the BJ-200ex printer driver
for Windows.
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Convenient Paper Handling
An automatic sheet feeder holds up to 100 sheets of plain
paper, 40 transparencies, or 15 envelopes.

Software Compatibility
Two resident printer control modes enable the printer to
work with a wide variety of software applications:

§ BJ-10 mode emulates the IBM Proprinter X24E printer.
§ Epson LQ mode emulates the Epson LQ-510 printer.

Three Print Modes/Speeds
The print modes allow you to choose between print quality
and speed.

§ HQ(high quality) mode provides high quality at 204 characters
per second (cps).

§ HS(high speed) mode provides draft quality printing at 248
cps.

§ Smoothing mode refines your printout by polishing away the
jagged edges and ragged stair-stepping curves of characters
and graphics, and enables the printer to print both text and
graphics at 720 x 360 dpi.

Reduction Mode
The printer offers two reduction modes for printing
spreadsheets and other wide documents on regular paper. In
reduction mode, the printer reduces the output to two-thirds
or one-half of its full size.
High Quality Ink
The ink in the BC-02 ink cartridge is not easily affected by
light, dries quickly, and is smudge-resistant.
Automatic Capping System
To ensure trouble-free operation, the printer automatically
moves the print head to the home position and caps the
print head whenever the printer is inactive or set off-line.
Simple Maintenance
The replaceable ink cartridge contains both the ink and the
print head; when it runs out of ink, you simply replace it.
TrueType Fonts
The Canon TrueType™ Font Pack enhances your font
capability and improves your print quality.
Compact Desktop Design
The printer is lightweight (6.6 lb / 3.0 kg) and occupies a
minimum amount of desk space.
Quiet Printing
The nonimpact printing method offers quiet operation.
On-Line Documentation
A detailed Visual Guide makes learning about the printer
easy and fast by displaying helpful information on your
computer screen within the Microsoft Windows
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environment. It includes detailed instructions for setting up
and using your printer as well as troubleshooting and
technical information.

Options and Supplies
Canon has an extensive dealer network equipped to offer
you supplies as you need them. To find a dealer near you,
call the Canon referral service at 1-800-848-4123.

If you want to purchase supplies directly from Canon, you
may do so by calling Canon Accessories at 1-800-671-
1090. Supplies are offered at the manufacturer's suggested
list price.

Ink Cartridge
Canon offers the following ink cartridge:

§ Canon Ink Cartridge BC-02 (black)

Print Media
Canon manufactures the following print medium for this
bubble jet printer.

Canon Transparencies Q07-001-M1
These overhead clear transparencies (also called Over Head
Projection or OHP film) are specially designed for Canon
Bubble Jet printers. Other overhead clear transparencies
may cause problems in your Canon printer by not feeding
correctly into the printer or by not allowing the ink to dry
properly. Canon overhead clear transparencies are specially
designed to produce crisp and professional overhead
presentations. Letter size is available.

Related Publication
Programmer's Manual
The information in the BJ-200ex Programmer's Manual is
intended for the software designer, the advanced
programmer, and the operator who can use a programming
language to send commands to the printer.
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To obtain this manual, call the Canon help desk as listed in
the next section.

 

Customer Support
Help Desk
Canon provides customer support and service for all Canon
printer products. If you have any questions regarding your
new printer, call the Canon Computer Systems help desk at
1-800-423-2366. Help is available Monday through Friday
from 8 A.M. to 11 P.M. Eastern Standard Time (EST) and
on Saturday from 11 A.M. to 6 P.M. EST. The help desk is
closed on Sundays and holidays.

If you seem to have an operational problem, try to solve it
by referring to the information in Chapter 7,
Troubleshooting, or by using your Visual Guide. If you
cannot quickly resume normal operations, contact Canon's
experienced support personnel at the help desk number
above.

Fax Number
You can send suggestions, and technical questions to
Canon via facsimile. The number for this service is 1-714-
438-3317, which accesses a G3 fax machine. Be sure to
state your question and provide a phone number or fax
number for a response.

Fax Retrieval System
Canon also provides a 24-hour toll-free fax retrieval
system. You can use this service to get helpful documents
faxed directly to your fax machine. These documents
contain useful information to assist you in the operation of
your Canon printer. To access this service, call 1-800-526-
4345.

Bulletin Board Services
Canon also provides a bulletin board service (BBS), which
is useful for obtaining newly developed, third-party drivers.
Call 1-714-438-3325. The protocol for the BBS is up to
14,400 bps, eight data bits, one stop bit, and no parity.

If you use CompuServe®, you can access the Canon
Peripherals Forum. This allows you to talk with other users,
send a message to Canon, or download printer drivers. Just
type GO CANON at any CompuServe prompt.
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Canada
Customer support for Canadian residents is available 24
hours a day (seven days a week) at 1-800-263-1121.

In other countries, please contact your Canon dealer.

Supplies
To order supplies, call Canon Accessories at 1-800-671-
1090 from 9 A.M. to 7 P.M. EST.

Servicing the Printer
The Canon BJ-200ex Bubble Jet Printer is designed with
the latest technology to provide trouble-free operation. The
warranty card that came with your printer describes
Canon's limited two-year warranty for its Bubble Jet
printers. Be sure to read the warranty information and save
the card.

If you seem to have a problem, try to solve it by referring to
the information in Chapter 7, Troubleshooting. If you
cannot solve the problem, contact Canon's support
personnel at the help desk.

If you fell that your BJ-200ex Bubble Jet Printer needs
servicing, call the Canon help desk to locate the Canon
Authorized Service Facility (ASF) nearest you or how to
find out about the exclusive Canon InstantExchange
limited warranty service.

At the time of this manual's writing, Canon does not offer
an extended warranty program beyond the two-year
warranty; however, some authorized Canon dealers may
offer such programs for a fee. If you are interested in an
extended warranty, contact your Canon Authorized Service
Facility to see if it offers such a service.
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Chapter 2
Setting Up the Printer

This chapter describes how to unpack the printer and select
a location for setting it up, examines the printer's
components, and explains how to assemble the printer. It
also describes how to load a stack of paper and print a self
test followed by installing the printer driver and managing
your printer's features.

If you already set up your printer using the Quick Start
Guide, you may want to look through this chapter to find
any additional information it supplies.

Unpacking the Printer
Follow these steps to unpack your printer:

1. Carefully remove all items from the box.
§ If you have lifted the printer's box using the built in handles,

press the cardboard handles toward the outside of the box
before trying to lift the printer out of the box.

§ It is best to have someone hold the box while you lift the
printer and its protective packaging out of the carton.
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2. Check to see that you have the following items:
§ Hardware

§ Documentation and Diskettes:

User's Manual (this manual)
Quick Start Guide
Product Warranty Card
Registration Card
Canon Windows Driver and Visual Guide
and WordPerfect™
Drivers diskettes (two diskettes in an
envelope)
TrueType Font Pack (diskette in envelope)

If your printer was damaged in shipping, or if any items are
missing, notify your dealer immediately.

§ In addition to the items shipped with your printer, you need a
Centronic®-compatible, parallel interface cable, which you can purchase
from your dealer.

§ Be sure to fill out your Registration card and send it to Canon Computer
Systems, Inc. Save your sales receipt for proof of purchase.

 
Removing the Shipping Materials

As you unpack the printer, save the carton and packing
materials in case you want to move or ship the printer in the
future. Follow these steps:
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1. Remove the shipping tape from the outside of the
printer.
§ Remove all pieces of tape. (The shipping tape may not be in

the exact locations shown here; just be sure to remove all the
tape from the outside of the printer.)

§ Remove the protector (plastic or Styrofoam) inside the sheet
feeder.

§ Move the paper guide to the left.

2. Remove the shipping tape inside the printer.
§ Open the front cover by grasping the sides of the cover and

pulling it down.

§ Remove the tape that secures the ink cartridge holder.
§ Make sure the paper thickness lever is set to the left for

printing on normal paper.
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Selecting a Location for Your Printer
Before you set up your printer, choose the best location for
it. Follow these guidelines:

§ Choose a flat, sturdy surface with enough space for the paper
to flow freely into and out of the printer. Angled print stands
may cause quality and reliability problems.

§ Fully extend the paper rest and paper output tray to ensure
enough space is available for proper operation. The printer
requires this much space:
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§ Place the printer where the temperature is stable and set for
human comfort. Avoid areas of excessive heat or humidity as
well as direct sunlight.

§ Do not install the printer near devices that contain magnets or
generate magnetic fields (such as loudspeakers or base units of
cordless telephones). These devices can erase information on
the printer's intelligent circuits.

§ Do not subject the printer to strong physical shock or
vibrations.

§ Keep the printer clean. Dust accumulation may prevent the
printer from functioning properly.

§ To protect the printer from damage, hold both sides when you
move it.

§ While the BJ-200ex Bubble Jet Printer is small and compact, it
is not designed for mobile printing.

Examining the Printer
Before setting up the printer, it's a good idea to familiarize
yourself with its parts and understand their functions.

From the Front
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Operator Panel
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From the Back
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Inside the Printer

Attaching the Power Cord

§ Use a power supply that is the appropriate voltage and frequency: AC
120 V, 60 Hz 0.5A. This is the standard for an electrical outlet in the
United States or Canada.

§ Use only the power cord that came with the printer. Using a longer
cord or an extension cord may result in reduced voltage or
malfunctions.

§ If you smell a peculiar odor or see smoke, unplug the power cord
immediately.

§ Do not place anything in front of your wall outlet that may obstruct
your access to it or put pressure on the power cord.
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§ When unplugging the power cord, always remove it by holding the
plug and not the cord.

To attach the power cord, follow the steps below.

1. Attach the power cord to the AC power receptacle on
the back of the printer.

2. Plug the power cord into a properly grounded AC
outlet.

 

Connecting Your Printer to the Computer
Your printer has an 8-bit parallel interface port, which
allows you to use it with IBM PCs and compatible
computers. You need to purchase a Centronics-compatible
parallel interface cable from your dealer. Ask your dealer
for assistance if you need help selecting the right cable.

NOTE: For reliable data communications between your computer
and the printer, use a short cable, six feet or less in length.

To connect the computer to the host computer, follow the
steps below:
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1. Make sure both the printer and the computer are
turned off.

2. Connect the parallel cable.
§ Align the cable connector with the printer's interface port so

the shapes match.
§ Gently press the cable connector into the port.
§ Secure the cable connector by snapping the two wire clips

(located on the printer) into the cable connector.

3. Connect the other end of the interface cable to the
parallel interface port on your computer.

 

Installing the Ink Cartridge
You use the BC-02 ink cartridge with this printer.
Each ink cartridge can print about 400 to 500 letter-
size pages (700,000 characters) in HQ mode and 800
to 1000 pages (1,400,000 characters) in HS mode.
The actual amount varies according to the print
density of a page. If you print a lot of graphics, you
may need to change cartridges more often.

NOTE: Canon makes numerous ink cartridges; the BC-02 is
designed specifically for the BJ-200ex and is the only one you
should use. Using the BC-01 cartridge will result in decreased
print quality.
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To install the in cartridge, follow these steps:

1. Grasp the sides of the front cover and open it so you can
access the cartridge holder.

2. Take the ink cartridge out of its protective packaging.

NOTE: Install the ink cartridge immediately after removing it
from its protective packaging.

3. Slide off the orange protective cap from the print head and
remove the orange tape.

4. Locate the cartridge holder on the right side of the printer.
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5. Lift the green lock lever on the cartridge holder.

6. Fit the ink cartridge over the yellow mounting base with
the print head facing down.

§ When installed correctly, the label on the cartridge will appear
upside down.
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7. Push the lock lever down until it locks into place.

§ Use one hand only to set the cartridge and press the lock lever
down.

§ Make sure there is no resistance when you press on the lock
lever. The lever should lock easily into place.

§ If you hear any snapping noises or feel any resistance as you
press down on the lever, remove the cartridge and try again.

8. Be sure no gap exists between the ink cartridge and
cartridge holder.

§ When secure, the ink cartridge makes contact with the circuit
card inside the cartridge holder.

Do not move the ink cartridge after installing it. Moving the ink
cartridge to the left and leaving it there may uncap the print head
and cause it to dry out.

9. Close the front cover.

When you turn off the printer, the ink cartridge moves to
the home position on the right and caps itself to keep itself
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from drying out. The cartridge will not cap and may dry out
or clog in the following cases:

§ If you unplug the printer while it is printing.

§ If you power off the printer via a power strip while it is
printing.

§ If you move the ink cartridge from the home position.

If, after installing the new ink cartridge, the printer seems to be
printing but no ink appears, stop the print operation. Remove and
replace the ink cartridge making sure it is secure.

 

Turning On the Printer
To turn on the printer's power, follow these steps:

1. Make sure the parallel interface cable is connected to your
printer and computer.

2. Make sure the power cord is attached to the printer and a
wall outlet.

3. Press the POWER button on the operator panel.

§ The POWER light flashes and the printer makes several
sounds as it warms up and gets ready to print.

§ When the printer is ready to print, the POWER, ON LINE,
and HQ lights are on.

To turn off the printer, press the POWER button again.
After turning off the printer, always wait at least five
seconds before turning it back on again.

Never unplug the printer or turn it off a power strip to which the
printer is attached when the printer's power is turned on. This may
prevent the print head from returning to the home position. Once
in the home position, the print head is capped, which prevents
damage or drying out. This is critical. If left uncapped, the print
head may clog, and you may have to purchase a replacement.
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Cleaning the Print Head
The print head on a new ink cartridge needs to be cleaned
to ensure the best possible print quality. The printer
automatically cleans the print head when you follow these
steps:

1. Make sure the printer is turned on and on-line.

2. Press the ON LINE and PRINT MODE buttons at the
same time.

§ When the ON LINE light starts to blink, release the buttons.

The ON LINE indicator will blink for about 12 seconds
while the printer cleans the print head. When complete, the
ON LINE indicator will stop blinking and go off. The
printer will stay off-line until you press the ON LINE
button.

Cleaning the print head consumes a small amount of ink.
Repeating this procedure unnecessarily reduces the life of the
cartridge.

Loading a Stack of Paper
These steps show how to load a stack of plain paper and
test your printer. In the next chapter, you'll learn how to
print on different types of print.

You can stack about 100 sheets of plain paper in the sheet
feeder.

1. Make sure the paper selection lever is set to the back
position.
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2. Pull the paper support up until it stops and pull out the
paper output tray.

3. Fan the paper.

§ For best results, fan the paper before loading it.

§ Always fan a stack of paper along the edge that will feed into
the printer first.
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4. Slide the stack of paper into the sheet feeder until it stops.

§ Align the edge of the paper with the right edge of the sheet
feeder.

§ Secure the stack with the paper guide.

Do not force the paper into the printer.

 

Printing a Test Pattern
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To check that you have properly set up the printer, you can
print one of the printer's test patterns. The test patterns are
described in detail in the next chapter. For now, print Demo
Print 1:

1. Press the POWER button to turn off the printer.
§ Wait a few seconds.

2. Make sure the paper is loaded.

3. Press and hold the ON LINE button, and press the
POWER button until the printer beeps twice.
§ The two beeps are approximately three

seconds apart.

The printer starts to print Demo Print 1:

4. To stop printing the Demo Print, press the ON LINE
button for one second.

§ The printer stops printing, ejects the page,
and goes back on-line.

 

Installing a Printer Driver
Before you can print documents from your software
applications, you must install the appropriate printer driver
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on your computer. The printer driver takes the information
from your application and translates it into a language the
printer can understand.

If you are using Microsoft Windows 3.1 applications,
install the Windows printer driver and Visual Guide as
described in the next section.

If you are using MS-DOS applications, you must install a
printer driver for each MS-DOS software application that
you intend to use with the printer. See Chapter 4, Using the
Printer With Your Software, for details.

Installing the Windows Printer Driver and Visual Guide
The Canon Windows Driver and Visual Guide diskettes
contain a setup program called SETUP.EXE. This program
automatically installs both the Canon BJ-200ex printer
driver for Windows 3.1 and the Visual Guide. You can
choose to install either the driver, the guide, or both.

Follow these steps:

1. Turn on your computer.
2. Make backup copies of the diskettes.
3. If you are not already in the Windows environment, type WIN

and press ENTER. Make sure the Windows Control Panel is
closed.

4. Insert the first diskette (Disk 1of 2) into the disk drive A (or
your desired drive).

5. From the Program Manager, select the File menu and then
choose the Run option.

6. In the Command Line prompt box, enter the path name that
identifies the SETUP.EXE file on the Windows driver diskette
and then click on OK. For example:

7. Now follow the instructions on the screen to install the
Windows driver and the Visual Guide.

The SETUP program installs the BJ-200ex printer driver
for Windows in the C:\WINDOWS\SYSTEM directory.
If you choose to install the Visual Guide, the SETUP
program creates an icon in the Program Manager.
Whenever you need information about the BJ-200ex, you
can open the icon and look up the information you need.
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For faster printing operations in Windows, do not use the
Windows Print Manager.

Using the Visual Guide
When the SETUP program is complete, you can start the
Visual Guide and take a look at its features. Simply open
the BJ-200ex icon in the Program Manager.

From now on, you can use the Visual Guide for all your
documentation needs. The Visual Guide contains all the
information included in this User's Manual. In addition:

§ It shows you photographs as well as illustration of all the
topics it covers.

§ It includes demonstrations and simulations of procedures you
actually perform.

§ It includes technical information regarding printer command
codes and ESCape sequences.

Using the Visual Guide, you can easily search for the topic
you are interested in and you can move forward and
backward through the guide with a click of your mouse.
If, for some reason, your computer and /or Visual Guide are
not available, you can look up the information you need in
the User's Manual.

Using the BJ-200ex Windows Driver
When you first install the Canon BJ-200ex driver for
Windows, it's a good idea to run the Setup program and
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select the printer settings that you will normally use. Later,
from within each of your software applications, you can
select the printer settings that are unique to the current print
job.

This screen shows the default settings for the BJ-200ex. see
Chapter 4, Using the Printer With Your Software, for
details on selecting other printer settings for the BJ-200ex
printer driver for Windows.

Installing the Canon TrueType Fonts for Microsoft Windows 3.1
1. Make sure your computer is turned on.
2. Start Windows 3.1 by typing WIN and pressing ENTER at the

MS-DOS prompt.
3. Choose the Control Panel from the Main icon group window

in the Program Manager.
4. Open the Fonts icon. The Fonts dialog box appears.
5. Choose the Add button to display the Add Fonts dialog box.
6. Insert the diskette containing the Canon TrueType Fonts into

the diskette drive.
7. In the Drives scroll menu, select the appropriate drive where

the diskette is located. The fonts appear in the List of Fonts
box.

8. Select the fonts by clicking on the fonts you want to add. To
select all the fonts, click the Select All button.

9. Click on OK. The Fonts dialog box reappears with the
installed fonts listed in the Installed Fonts menu.

10. To ensure the fonts appear in your application, click the
TrueType button. The TrueType dialog box appears.

11. Make sure an X appears in the Enable TrueType Fonts box.
Click on OK to exit the TrueType dialog box.

12. Click on Close to exit the Fonts dialog box.
Your installation is now complete.
If you would like to remove the installed fonts, please refer
to the instructions that came with your TrueType fonts.
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Managing Your Printer's Features
You select and control the printing features of the BJ-200ex
printer with your software application, with the printer's
operator panel, or with the printer's DIP switches. Each
method allows you to select some or all of the printing
features that control the appearance of your printed
documents.

Software Applications
Your software applications, when used with the appropriate
printer driver, can control all aspects of the printer's
features. This is the easiest method for controlling the the
look of your printed documents, including typeface style,
and size and placement of text, graphics, and margins.
Normally, settings made with your software applications
override the settings made through the operator panel or the
DIP switches.

See Chapter 4, Using the Printer With Your Software, for
details on setting up your software applications for use with
the BJ-200ex.

Operator Panel Buttons
The buttons on the operator panel allow you to turn the
printer on and off, set the printer on-line and off-line, pause
a print operation, select basic printing modes, feed paper,
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clean the print head, start a printer self test, and turn on
automatic line feeds.

See Chapter 5, Using the Operator Panel, for details.

DIP Switches
The printer's DIP switches allow you to set the default
printer configuration settings, such as paper and envelope
size, text lines per page, character sets, and so on. See
Chapter 8, Customizing the Printer, for details.

 

Line Printers Versus Page Printers
Line Printers
Your Canon BJ-200ex Bubble Jet printer is an example of a
line printer. Line printers, sometimes called band printers,
process and print information one line (band) at a time. The
information sent from the computer to the printer indicates
exactly how each line should look and where each dot is
positioned. This information is similar to a bitmapped
graphic that specifies positions of individual dots of ink.

Page Printers
Page printers process and print information one page at a
time. The information sent from the computer to the printer
is sometimes in simple ASCII code, or more often, in a
page description language. This information is a set of
instructions that the printer must interpret to determine
where the printer should position each dot. Some common
page description languages include PostScript, CaPSL, and
HP PCL.

Line Printers and Processing
With line printers almost all of the processing burden falls
on the computer. The printer needs to do very little
additional processing of the information it receives from
the computer-it simply executes the instructions it receives.
This means a line printer needs very little processing power
and memory.

Because most of the processing takes place on the
computer, the speed of the computer's processor (386, 486,
Pentium) and the amount of random access memory(RAM)
on your computer have a significant influence on printing
speed.

Download from Www.Somanuals.com. All Manuals Search And Download.



The faster the processor, and the more RAM you have, the
faster you can print on your BJ-200ex Bubble Jet Printer.

Page Printers and Processing
With page printers, the computer and the printer share the
processing load. The computer translates information from
the application into the appropriate page description
language and sends this to the printer. The printer processes
this code into the specific printing instructions on where to
put each dot on the page. This means that the printer itself
must have a certain amount of processing power and
memory to handle the instructions it receives from the
computer.

Because processing takes place on both the computer and
the printer, the speed of laser printing depends on the
processor speed and RAM available on both the computer
and the printer.

 

Congratulations
You are now ready to start using your new printer. See
Chapter 3, Using the Printer, for instructions on how to
perform various printing operations.
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Chapter 3
Using the Printer

This chapter describes how to use the printer for all your
printing operations, such as printing documents, single
sheets, special papers, and envelopes. It includes how to
print the self tests as well as print on legal size paper and
print in landscape orientation. It also describes how to
pause a print operation.

To ensure the best performance of your printer, you want to
select the best paper and load it correctly. You can stack
paper in the sheet feeder to load it automatically, or you can
manually feed one sheet at a time. The path that the paper
travelks through the printer is the same for automatic and
manual feeding.

 

Selecting Paper Types
One of the most important things you can to do assure the
best possible performance of your bubble jet printer is to
select the correct paper. Your printer produces letter quality
output on most plain papers; it does not require special ink
jet papers. However, the print quality varies with different
paper types. Be sure to test a type of paper before you
purchase a large quantity.

Plain Papers
The printer supports paper sizaes of letter, legal, A4, and
B5 in portrait orientation. You can use regular copier paper,
cotton bond papers, and typical letterhead. Always use
paper without curls, folds, staples, or damaged edges.

Transparencies
The Canon transparency film (Q07-0001-M1) is
recommended. It is available in letter size.

When selecting or loading paper, keep these guidelines in
mind:

§ Attempting to print on damp, curled, wrinkled, or torn paper
can cause paper jams and poor print quality.

§ Use cut-sheet paper only. You cannot use multipart paper.
§ When using graph paper, the lines may not match because the

1/6-inch line spacing of the printer is slightly less than that of
graph paper.
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§ If the print density of your page is very high, light paperstock
may curl slightly due to the large amount of ink. If you need to
print heavy graphics, try printing on heavier stock.

§ Do not use thicker paper than meets the specifications for this
printer. Printing with a paper that is thick enough to come in
contact with the print head nozzles may damage the print head
unit.

For complete paper specifications, see Appendix A,
Specifications.

 

Before Loading Paper
To ensure trouble-free paper handling, you'll want to set the
paper thickness lever and paper selection lever before
loading paper.

Setting the Paper Thickness Lever
You use the paper thickness lever to adjust the distance
between the print head and the paper to accommodate
different paper thicknesses. This distance is called the print
gap.

Set the lever according to the thickness of the paper you are
using:

§ Left is for printing on normal paper or transparencies.

§ Right is for printing on thick paper or envelopes.
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Always set the paper thickness lever before and after printing on
thick paper or envelopes.

If you are printing documents with high density graphics or
ink and the printed pages are smudges, try setting the paper
thickness lever to the right position. This unit moves the
print head unit further from the paper. Print quality may
diminish slightly, but the smudges should go away.

Setting the Paper Selection Lever
Set the paper selection lever to the proper position before
loading paper. There are two positions according to paper
type:

§ The back position is for normal plain paper or transparencies.
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§ The front position is for automatic loading of envelopes and
for manually feeding any type of print media.

§ Do not move the paper selection lever after loading paper in the
sheet feeder.

§ This lever is different from the lever on a typewriter or dot matrix
printer. You need not pull it forward to load paper. You set the
paper selection lever to the front position only when loading
envelopes or when manually feeding paper. If it is set to the front
position when you are automatically feeding stacks of normal
paper, the printer may feed multiple sheets or jam.

§ Be sure to remove any paper from the sheet feeder before setting
the paper selection lever.

When the paper selection lever is in the back position, a
lever inside the printer prevents the paper from advancing
into the printer. When you move the paper selection lever
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to the front position, the lever inside the printer moves so
that the single sheet being fed can advance into the printer.

It is important that you set the paper selection lever to the
correct position based on how you plan to feed paper. Be
sure to set the paper selection lever before loading paper
and do not move the lever after loading the paper.

Printer Settings for Various Print Media
The following table summarizes the printer settings for the
various types of print media:

Paper type

Paper
thickness
lever

Paper
selection
lever

Loading
method

Plain Paper Left Back Automatic
Envelope Right Front Automatic

Transparency Left
Back or
Front

Automatic
or Manual

Thick paper Right
Back or
Front

Automatic
or Manual

If you have a problem with the paper misfeeding, see
Chapter 7, Troubleshooting, for possible solutions.

Printing Documents
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When you want to print a multiple page document, load a
stack of papers in the sheet feeder. The printer
automatically feeds each sheet when your software
application tells it to start printing the page. How you
actually print from within a program is dependent on the
application. For example:

§ In Microsoft Word for Windows, you select the Print
command from the File menu.

§ In Microsoft Word for MS-DOS, you select the Print
command from the Command menu.

See your application's documentation for details.
Specifying Print Options

For each print operation, you need to specify certain print
functions in the printer driver. For example, you need to
identify the size and type of paper you are printing on and
that the paper is being loaded automatically from the sheet
feeder. Your default settings may match the current print
operation. If the print options for the current print operation
are different from the default settings, you can change them
from within your application.

For example:

§ In Microsoft Word for Windows 2.0, you can select Print
Setup from the File menu and then select Setup from the
Printer Setup dialog box. Windows displays the Canon BJ-
200ex Setup dialog box in which you can define all your
printer settings. See Chapter 4, Using the Printer With Your
Software, for complete details on the printer settings you
select using the Windows printer driver.

§ In Microsoft Word for MS-DOS, you canselect Print from the
Command menu, and then select Options from the Print menu.
The Print Options menu then allows you to define your printer
settings.

After making your print selections, you can prepare the
printer for automatically feeding paper.

Automatically Feeding Paper
You can place approximately 100 sheets of plain paper (20
lb or 75 g/m²) in the sheet feeder at a time. (For instructions
on automatically feeding special paper, see Printing on
Special Papers later in this chapter.)

To automatically feed plain paper, follow these steps:

1. Make sure the paper thickness lever is left for printing on
normal paper.
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2. Make sure the paper selction lever is set to the back
position.

3. Extend the paper support and the paper output tray.

§ Pull the paper support up until it stops. The
paper support keeps paper straight and limits
the possibility of jams.

§ Extend the paper output tray.
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4. Fan the paper

§ For best results, fan the paper before loading
it.

§ Always fan a stack of paper along the edge
that will feed into the printer first.

5. Slide the stack of paper into the printer until it stops.
§ Align the edge of the paper with the right

edge of the sheet feeder.
§ Insert the paper so that the side you want to

print on is facing you. If you are using a
preprinted stock, such as letterhead, insert
the top of the paper into the sheet feeder
first.

§ Make sure the stack of paper does not
exceed the paper limit mark on the right side
of the sheet feeder.
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Do not force the paper into the printer.

6. Adjust the paper guide to the stack of paper.

§ This keeps the paper feeding straight into
the printer and reduces skewing.

§ Be sure there is no gap between the paper
guide and the edge of the stack of paper.
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7. Make sure the printer is turned on and on-line. Start your
print operation.

 
Auto Feed Guidelines

When automatically feeding stacks of paper, follow these
guidelines:

§ Do not leave paper stacked in the printer for long periods of
time; longer sheets of paper may become bent or curled over
time. This may cause the paper to misfeed or jam.

§ If your printed page contains lots of graphics, the ink on the
page may be damp due to the print density. Remove the page
right away and allow the ink to dry.

§ The capacity of the paper output tray is 20 sheets of paper. To
reduce paper jams, remove paper from the output tray before
the count reaches 20.

§ If paper curls after printing, remove it immediately; otherwise,
paper jams may occur.

§ The platen (a roller on the inside of the printer) may become
inked if you print data beyond the width of the page. If this
happens, clean the platen with a soft cloth. (For details on
cleaning the platen, see Chapter 6, Maintaining the Printer.

§ Depending on the density of your printed pages, the ink may
need time to dry.

§ Do not try to load paper into the sheet feeder beyond the paper
limit mark (>|) on the right side of the sheet feeder; stacking
too much paper may cause paper feeding or printing problems
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§ Make sure there are no gaps between the stack of paper and
the paper guide nor the right edge of the sheet feeder.

Printing Single Sheets
When you want to print a single page or thick paper, you
can manually feed single sheets of paper.

Specifying Manual Feed
In the Windows driver, you must select Manual Feed for
the Paper Source.

If you are using an MS-DOS application, your driver
should have a manual feed selection. For example, in
Microsoft Word, the Print Options menu includes a Paper
Feed option for which you select Continuous or Manual.

Manually Feeding Paper
You use the manual function when printing on heavier
weight paper (up to 28 lb or 105 g/m²).

To manually feed a single sheet, follow these step:

1. Make sure the printer is turned on and on-line.
§ The POWER, ON LINE, and HQ lights are

on.
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2. Open the top cover and check the paper thickness lever.

§ If you are manually feeding thick paper or
transparencies, set the paper thickness lever
to the right.

3. Set the paper selection lever to the front.
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4. Extend the paper support and the paper output tray.
5. Insert the single sheet.

§ Slide in the paper until it stops inside the
sheet feeder and hold it for about two
seconds.

§ Align the sheet with the right edge of the
sheet feeder.

§ Adjust the paper guide to the sheet.
§ The printer automatically loads the paper

into position.
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6. Start your print operation.

§ If you are using Windows, you must select Manual Feed using the
BJ-200ex printer driver for the printer to accept manually fed
paper.

§ After printing on thick paper or envelopes, set the paper thickness
lever (inside the printer) to the left before printing on normal paper.

§ After manually feeding a sheet of paper or an envelope, set the
paper selection lever to the back position.

Printing on Transparencies
You can stack approximately 40 transparencies in the sheet
feeder. However, this special medium may not advance
correctly under unusual environmental conditions (such as
extreme temperatures and humidity). If you have trouble
with transparencies becoming skewed or feeding multiple
sheets, do not stack them in the sheet feeder. Load them
manually as described earlier in the chapter.

Place at least one sheet of plain paper in back of a stack of
transparencies.
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When you are ready to print on transparencies, open your
document withing your software application and define any
special print options you can from within your print driver.
For example, if you are using Windows, you can specify
the Paper Size, Media Type, Paper Source, Print Selection,
and Print Quality from within the printer driver.

Once your software and driver are ready to print, you can
set up the printer for auto feed or manual feed. Both
methods are described earlier in this chapter.

Follow these guidelines when automatically feeding stacks
of special paper.
§ When automatically feeding transparencies, remove each sheet

after it is delivered. Do not allow transparencies to stack up in
paper output tray.

§ Let the printed transparencies dry completely before storing them. The complete
drying time required for Canon's transparencies is approximately 15 minutes.

§ When a transparency has dried completely, cover its printed side with a sheet of
plain (not coated) paper before stroing it; this is recommended even if you place
the transparency in a clear file.

Printing on Envelopes
You can stack up to 15 envelopes in the sheet feeder or you
can manually feed envelopes one at a time.
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U.S. Commercial number 10 (COM 10) envelopes and
European DL envelopes are recommended. You may be
able to stack envelopes of other sizes in the sheet feeder;
however, Canon cannot guarantee consistent performance
on envelope sizes other than COM10 and DL.

The following envelopes are not recommended because
they may cause jams or smears, or may damage your
printer:

§ Envelopes with windows, holes, perforations, cutouts, and
double flaps.

§ Envelopes made with special coated paper or deeply embossed
paper.

§ Envelopes using peel-off sealing strips.
§ Envelopes in which letters have been enclosed.

Preparing Your Software
How you create envelopes within your software application
depends on the application. See your application's
documentation for details.

If you are using the BJ-200ex printer driver for Windows,
change the Paper Size setting to Envelope.

Check your software to see if it prints envelopes in portrait
or landscape orientation. It's a good idea to print on a sheet
of paper before printing on an envelope to check the
orientation.

Printing on envelopes in portrait orientation results in faster
printing. However, several software packages, such as
WordPerfect and Word for Windows, default to landscape
orientation. This requires adjustments in the software to correctly
print on envelopes with this printer. See Appendix B, Application
Notes, for details.

Turning On the Printer's Envelope Mode
If you are not using Windows and your software
application does not have an envelope feature, you can turn
on the printer's envelope mode using the operator panel.
Follow these steps:

1. Make sure the printer is turned on and on-line.
2. Turn on the envelope mode:

§ Press and hold the LF/FF button and press
the ON LINE button.

Download from Www.Somanuals.com. All Manuals Search And Download.



§ The printer beeps once and the indicator
light for the current print mode blinks
rapidly.

§ Press ON LINE to set the printer on-line.

§ Use the envelope mode only when you are loading envelopes; do not
use this mode when loading regular or thick paper.

§ Selecting envelope mode cancels reduction mode (if set).

Preparing the Printer
When you are ready to print on envelopes, follow these
steps to stack envelopes in the sheet feeder. (You can also
manually feed envelopes one at a time.)

1. Set the green paper thickness lever to the right.

2. Set the paper selection lever to the front.
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3. Move the paper guide to the left to match the width of the
envelopes.

4. Extend the paper support and the paper output tray.
5. Prepare the envelopes.

§ Arrange the stack of envelopes on a firm
surface and press down firmly on the edges
to make the folds crisp.

§ Press around the envelopes to remove and
curls and expel air from inside the
envelopes.

§ Also, press firmly on the area that
corresponds to the edges of the flap.

6. Insert the envelopes

§ Slide the stack of envelopes into the sheet
feeder until it stops.

§ Align the stack of envelopes with the right
edge of the sheet feeder.
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7. Adjust the paper guide to the stack of envelopes.

When printing on COM10 envelopes, move the paper guide all
the way to the left. Depending on the size and shape of your
interface connector, the paper guide may touch it. If this causes
the envelopes to misfeed, use an interface cable with a smaller
connector.
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8. Make sure the printer is on-line and start your print
operation.

Turning Off Envelope Mode
After printing on envelopes, follow these steps before
loading normal paper again:

1. Set the paper selection lever (on the right side of the sheet
feeder) to the back position.

2. Set the green paper thickness lever (inside the printer) to
the left position.

3. If you enabled the envelope mode, disable it now.
§ Make sure the printer is on-line; then press

and hold the LF/FF button and press the ON
LINE button.

§ Press the ON LINE button to set the printer
back on-line.

4. In your Windows driver, change the Media Size setting
back to 8.5 x 11 inches or to the paper size you are using.

Printing on Legal-size Paper
You can print on legal-size paper by selecting a page size
of 8.5 x 14 from within your software application or from
the printer setup program within the application.

For example, if you are using Windows, simply select
Legal for your paper size in the Setup program:

 
If you are

using Word for Windows, version 2.0, follow these steps to
select the paper size:

1. From the top menu bar, select Format and then Page
Setup.

2. In the Page Setup dialog box, select the Size and
Orientation attribute button.

 
3. Select the Paper Size menu bar to choose

different options and select Legal (8.5 x 14 in).

4. Select OK to verify the changes.

In some MS-DOS applications, you may need to specify
the page length in lines per page. For letter-size paper, the
page length is 64 lines, and for legal-size paper, the page
length is 82 lines.
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If you are using an application that does not include a page
setup or printer setup procedure, you may be able to use the
ESCape sequence to specify your page length. Applications
handle ESCape sequences differently, so refer to your
application's software manual for instructions on sending
commands.
The ESCape sequence for page length is ESC 0 n, where n
is the page length in inches. For legal-size paper, the
ESCape sequence is ESC 0 14 (27 67 0 14, decimal, or 1B
43 00 0E, hexidecimal).
When printing on legal-size paper, do not extend the paper
output tray:

Remove each sheet as it is printed.

Printing in Landscape Orientation
The BJ-200ex Bubble Jet Printer does not have built-in
landscape fonts. However, you can print in landscape
orientation through the Windows environment.
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If you are not using Windows, you can consider many other
software packages that offer landscape font capabilities,
sucj as:

Quatro Pro 3.0
Lotus 2.4
Geoworks
WordPerfect 6.0 for MS-DOS

The following font packages work with the specified
software applications. (Product names may be trademarks
of their respective companies.)

• WordPerfect 5.0 and 5.1
Bitstream Facelift for WordPerfect
More Fonts
Fonts On the Fly
The Publishers Power Pack

• Lotus 2.0, 2.1, and 2.2
Sideways

• Microsoft Windows 3.1
Adobe Type Manager
Bitstream Facelift for Windows
The Publishers Power Pack
TrueType Font Packs

Many other graphics software packages offer landscape
printing. Call your specific software manufacturer to see if
they offer landscape printing capabilities.

Printing the Test Patterns
There are three test patterns that you can use to check the
operation of the printer: the Self Test, the Font List, and the
Demo Print. Use these test patterns to check the operation
of the printer.
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To print the test patterns, you must be automatically
feeding paper. Make sure the paper selection lever is set to
the back position.

Use letter-size or A4-size paper when printing the test patterns. If
you attempt to print on a smaller sheet, ink will get on the platen.
If this happens, see Chapter 6, Maintaining the Printer, for a
description of how to clean the platen.

Self Test
You can print the Self Test in both printer control modes:
BJ-10 mode or Epson LQ mode. The printer prints a
repeating pattern of characters in the default print mode and
pitch.

In BJ-10 mode, the pattern is printed is Courier typeface at
10 cpi; the print mode is HQ. In Epson LQ mode, that
pattern is printed in Roman typeface at 10 cpi; the print
mode is HQ.

Starting

To start the Self Test, follow these steps:

1. Press the POWER button to turn off the printer.
2. Press and hold the ON LINE and PRINT MODE buttons,

and press the POWER button until the beeper sounds
once.
§ The printer starts to print the self test.

Stopping
To stop the self test, press and hold the ON LINE and
POWER buttons for one second. The printer stops
printing, ejects the current sheet of paper, and goes back
on-line.
In BJ-10 mode, the Self Test looks like this:
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In Epson LQ mode, the self Test looks like this:

Font List
You can print this sample in both printer control modes:
BJ-10 mode or Epson LQ mode. The printer prints all
characters in the available print styles and pitches.

Starting

To start the Font List, follow these steps:

1. Press the POWER button to turn off the printer.
2. Press and hold the ON LINE button, and press the

POWER button until the beeper sounds once.
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§ The printer starts to print the Font List.
Stopping
To stop printing the Font List, press and hold the ON LINE
button for one second. The printer stops printing, ejects the
current sheet of paper, and goes back on-line.
In BJ-10 mode, the Font List looks like this:

In Epson LQ mode, the pattern looks like this:

Demo Prints 1 and 2
You can print these samples in both printer control
modes:BJ-10 mode or Epson LQ mode. Demo Print 1
shows normal mode and Demo Print 2 shows Smoothing
mode. The Demo Prints describe a few of the printer's
features in different languages.

Starting
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To start the Demo Prints, follow these steps:

1. Press the POWER button to turn off the printer.
2. To start Demo Print 1: press and hold the ON LINE

button, and press the POWER button until the beeper
sounds twice.
§ The two beeps are approximately three

seconds apart.
§ The printer starts to print Demo Print 1.

3. To start Demo Print 2: press and hold the ON LINE
button, and press the POWER button until the beeper
sounds three times.

§ The first two beeps are approximately three
seconds apart. The next beep is one second
later.

§ The printer starts to print the Demo Print 2.
Stopping
To stop printing the Demo Print, press and hold the ON
LINE button for one second. The printer stops printing,
ejects the current sheet of paper, and goes back on-line.
Demo print 1 looks like this:

Demo Print 2 is similar to Demo Print 1 but shows the
advantages of Smoothing mode. In Smoothing mode, the
jagged edges and ragged stair-stepping curves of characters
and graphics are polished and refined.

Pausing a Print Operation
When the ON LINE light is on, the printer is on-line and
ready to receive data from your computer. At this time, you
can send print data from your computer to the printer.

While you are printing a document, you may want to pause
the printer.
Follow these steps:

1. To pause printing while the printer is working, press the
ON LINE button.
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§ The ON LINE light will go off; the printer
will stop printing and go off-line.

2. To start printing again, press the ON LINE button.

3. If data remains in the print buffer, the ON LINE light
blinks.

§ To print the data, press the ON LINE button
to set the printer off-line and then press the
FF button.
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Chapter 4
Using the Printer With Your Software

Your printer will work with a wide variety of applications,
such as spreadsheet, word processing, and graphics
programs. This chapter describes how to set up your
software applications for your printer.

Application programs include a group of programs, called
printer drivers, that help the application communicate
correctly with specific printers. Before using the printer
with your application program, you need to tell the
application what type of printer you are using by selecting
the printer driver that corresponds to your printer.

Canon provides a BJ-200ex printer driver for Microsoft
Windows. The easiest way to use your printer is to install
the Windows driver and perform your print operations
through the Windows environment.

If you are using Microsoft Windows, you have already
installed the driver (as described in Chapter 2, Setting Up
the Printer). Also, in the last chapter, Using the Printer,
you learned that there are certain print options you can
select through your printer driver.
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If you are not using Windows, see the section Setting Up
MS-DOS Software Applications (later in this chapter) for
information on how to install another printer driver and
select a printer control mode.

Printer Setup Within Windows
After you install the Canon BJ-200ex printer driver, you
can run the Windows Setup program to change printer
settings.

You can access the Setup program from the Printers dialog
box in the Control Panel, or you can select the Print Setup
option that is available from the File menu of most
applications that run in Windows.

If the Print Setup option does not appear in the File menu for your
application, refer to the user's manual supplied with the
application. It should provide information about changing the
printer setup parameters.

To configure your BJ-200ex printer driver, follow these
steps:

1. Start the application you want to use in the Windows
environment.

2. Open the document you want to print.
3. Choose Print Setup from the File menu. The Select Printer

dialog box appears.
4. Click once on the Canon BJ-200ex printer name to select it.
5. Click on the Setup button. Windows displays the Canon BJ-

200ex Setup dialog box.

From this screen, you can select the Paper size, Media Type,
Paper Source, Print Selection, Print Quality, Resolution, and
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Orientation for your print job. You can use these options in
any combination. see the next section for more detailed
Information about the options.

6. Once you select the options you want to use, click on the OK
button to close the Canon BJ-200ex setup dialog box, and then
click on the OK button to close the Print Setup dialog box.

Selecting Printing Options
This section describes the printing options available to you
through the BJ-200ex printer driver.

If other options appear in the dialog box, they are provided by the
application you are using. Refer to that application's
documentation for more information.

Paper Size option

Click on the arrow next to the Paper Size setting to select
one of the following paper sizes from the drop down list:

When printing on envelopes or thick paper, make sure the paper
selection lever is set to the front position and the paper thickness
lever (inside the printer) is set to the right.

If you select User Defined Size, the Setup program displays
the following dialog box:

Select the unit of measure you are using (inches or
millimeters), and then specify the width and length of your
paper. The width can be from 4.1 to 8.5 inches (104.1 x
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215.9 mm). The length can be from 4.1 to 14 inches (104.1
x 355.6 mm).

Media Type option

Click on the arrow next to the Media Type setting to select
one of the following types of paper from the drop-down
list:

When you select the Media Type, the Windows driver
changes printer modes. You can experiment with different
settings to see the results you can achieve on different types
of media. You may find that you can produce higher
quality printing on plain paper using the Transparency
mode.Because each situation is different, Canon cannot
guarantee better output output for a particular medium
other than the recommended choices.

Plain Paper
This mode is for printing on ordinary paper. This selection
sets the dots generated by the printer to yield the highest
quality printed image for this type of paper with minimal
bleeding.

• When you select Plain Paper, the Paper Source defaults to
Auto Sheet Feeder and the Print Quality defaults to Normal,
360 x 360 dpi.

• When you are printing on plain paper, set the paper thickness
lever (inside the printer) to the left position.

Transparency
This mode is for printing on transparency stock. Use the
Canon Transparencies (Q07-0001-M1) to achieve the
highest possible color fidelity.

• When you select Transparency, the Paper Source defaults to
Auto Sheet Feeder and the Print Quality defaults to Fine, 360
x 360 dpi.

• When you are printing on transparencies, set the paper
thickness lever (inside the printer) to the left.

• When manually feeding paper, change the Paper Source to
Manual Feed and make sure the paper selection lever is set to
the front position.

Paper Source option
Click on the arrow next to the Paper Source setting to
select one of the following paper sources from the drop-
down list:
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When using manual feed, it is a good idea to turn off the Print
Manager in the Printers dialog box.

If you are feeding paper manually and using the spooler,
the printer goes off-line before printing each page to allow
you to insert paper.

When you select Manual Feed, be sure to set the paper
selection lever on the printer to the front position.

Print Selection option

Click on the arrow next to the Print Selection setting to
select one of the following options from the drop-down list:

Black and White
This option prints documents in black ink only. Use this
setting when printing text files that have no graphic images.

Grayscale
Use this option to produce graphic images in shades of
gray.

Print Quality options

Click on the Print Quality selections when you want to
use:

Adjust the Print Quality setting to match your printing
needs:

§ High speed (left position) - Use this mode for your fastest
printing speed at a lower resolution of 180 x 180 dpi. This
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setting reduces the resolution to improve your application's
processing time. Use this setting to print draft copies of your
work.

§ Normal (center) - Use this mode for your best quality text and
simple graphics. The printer prints at a resolution of 360 x 360
dpi.

§ Fine (right position) - Use this mode to intensify the printed
image. The printer prints at 360 x 360 dpi but makes multiple
passes as it prints; this produces very high quality but is
slower than normal HQ mode. If you need very high quality
print or are having problems with banding, try this selection.

§ Smoothing (check box) - Use this mode to print at the highest
resolution, 720 x 360 dpi. You can select Smoothing with
Normal only.

Orientation option
Click on the Orientation setting you want to use:

The page orientation determines the direction of printing on
the page:

Other selections
§ Click on Options to access the special options provided by the

BJ-200ex printer driver for Windows. These options are
discussed in the next section.

§ Click on About to display copyright information regarding the
Windows driver and its version number.

§ Click on Help to enter the Help program. This program
provides information to help you specify your printer settings.

Special Options
The BJ-200ex printer driver for Windows provides several
special options. From the Canon BJ-200ex Setup dialog
box, click on the Options button.
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These options allow you to select the halftone method you
want to use, and increase or decrease the intensity of the
printed images.
Halftone
This option is available only when the Print Selection is
grayscale.
When you click on the arrow next to the Halftone setting,
you can select the following options:

Pattern 1 and Pattern 2
This setting uniformly aligns individual dots to create
shades of gray. This method offers faster printing speed and
is best suited for printing documents that contain large
areas of solid color, such as bar charts and graphs.

Diffusion
This setting randomly places individual dots to create
shades of gray. By randomly placing dots, the printer can
achieve subtle gradations. This method is best suited for
printing documents that contain finely detailed graphics or
photographic images.
Using diffusion slows the application release time because
a larger, more complex page is generated by the software.
This type of page requires more time to calculate as well as
send to the printer. However, what you lose in print speed
may be gained in quality.
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The diffusion setting may help eliminate banding problems
when printing grays on all black images.

Intensity
You can use this option to adjust the Intensity of the
printed image. Click on the arrows to make the image
darker or brighter, or drag the slider box right or left along
the bar.

Printing a Document
This procedure provides general steps for printing from the
various applications you may run in the Windows
environment. The exact steps for printing a document may
vary depending on the application program you are using.
Refer to your program's documentation for the exact
printing procedure.

1. Start the program you used to create the document, and open
the document you want to print.

2. Choose Printer Setup from the File menu.
3. Select the Canon BJ-200ex as your printer and select Setup.
4. Make any adjustments as appropriate for printing your

document, and select OK.
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5. Select OK to close the Printer Setup window.

6. Choose Print from the File menu.
7. After making any necessary changes to the printing

parameters, select OK to start the print job.

It's a good idea to turn off the Print Manager if you are feeding
paper manually. To do so, clear the Use Print Manager check box
in the Printers dialog box within the Control Panel.

If you are feeding paper manually and using the spooler,
the printer goes off-line before printing each page to allow
you to insert paper.

Ways to Improve Print speed in Windows
To improve printing speed, you can try the following:

§ Turn off the Print Manager in the Windows Control Panel
This avoids the extra step of sending the print file to the Print
Manager and may increase your printing speed by as much as
25%, depending on the computer you are using. (See the next
section for details.)

§ Add a permanent swap file in Windows
Under the 386 Enhanced icon in the Windows Control Panel,
add or create a permanent swap file that is from 4 MB to 9
MB. The computer will be able to prepare the print file faster.
See your Windows documentation for instructions.

§ Avoid diffusion halftones
In the Options dialog box, choose Diffusion only when
printing final output or photographic images. Choosing Pattern
allows documents to print as much as 20% faster because the
computer does not need to compute to "best possible position"
for each dot.
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§ Free up your memory
Use only one software program at a time and unload any
screen saving utilities or programs stored in Windows
background; this frees up more memory for Windows
processing.

§ Use Black and White when possible
If you will be printing text in black ink only, choose Black and
White rather than Grayscale.

§ Use high speed (draft) modes
The printer will need to image fewer dots.

§ Add RAM to your computer
The computer will be able to prepare the print file faster.

§ Use a computer with a faster processor
The computer will be able to prepare the print file faster.

 

Using the Windows Print Manager
The Print Manager is part of the Windows operating system
and controls the printing of your files.

Background Printing

When the Print Manager is active, the print file that your
application and printer driver create is not sent directly to
the printer. Instead, the print file is sent to the Print
Manager. The Print Manager then sends the print file to the
printer.

This means the Print Manager allows you to print in the
background. Once the Print Manager receives the print file
from the application, you can continue to use your
computer for other work. The Print Manager will send the
print file to the printer when it has the time and memory
available to do so.
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Because most of the print is actually the processing time
needed for the computer to prepare the print file,
background printing does not usually give you any real
advantage.

Foreground Printing

If the Print Manager is not active (turned off), the print file
that your application and printer driver create is sent
directly to the printer. This means you are printing in the
foreground and you cannot use your computer for other
work until you have finished printing.

Printing usually works best with the BJ-200ex when the
Print Manager is turned off. You can turn off the Print
Manager by using the Control Panel in the Main Group
window. Select the Printers icon, then click on the X that is
in the Use Print Manager check box. (This will make the X
disappear.)

Setting Up MS-DOS Application Programs
If you are not using Windows, follow the guidelines in this
section for setting up our applications for use with the
Bubble Jet Printer BJ-200ex. If you installed the Canon BJ-
200ex Windows printer driver as described in the previous
section and will be printing only under Windows, you can
ignore this information.
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Software applications are designed to work with specific
hardware setups. Most Application programs include an
installation program or routine that you run to identify the
type of hardware you are using, such as your computer and
printer. When you tell your application program what
printer you are using, it installs a program, called a printer
driver, that supports your printer.

Selecting a Printer Driver
The installation programs for most applications offer a list
of printer drivers form which to choose. If you find Canon
BJ-200ex on the list, select it. This will give you the fullest
range of features.

If you do not find one of these printers on the list, you can
select a printer that will have nearly the same operating
capabilities as the Bubble Jet Printer BJ-200ex.

Software developers continuously create printer drivers. If your
application software does not list a Canon BJ-200ex driver, call
your software application's technical support line and ask if a BJ-
200ex driver is available. If they are unable to assist you, call the
Canon help desk to see if a driver is available.

To use the printer in BJ-10 mode, select one of the
following printers (they are listed in order of preference):

Canon BJ-200ex
Canon BJ-200
Canon BJ-230*
Canon BJ-10e/BJ-10ex/BJ-20
IBM Proprinter X24E/XL24*
IBM Proprinter X24/XL24E*
Canon BJ-130e*
IBM Proprinter*

To use the printer in Epson LQ mode, select one of the
following printers (they are listed in order of preference):

Canon BJ-200ex
Canon BJ-200
Canon BJ-230*
Canon BJ-20 (LQ)
Canon BJ-10e/BJ-10ex (LQ)
Epson LQ-510
Epson LQ-850
Epson LQ-500
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Epson LQ-1050*
Epson LQ printer

* These printers support paper that is wider than 8.5 inches.
After selecting a printer, you can use software commands
for all the standard printer functions through the application
program. This includes bold or double-strike printing,
underlining, subscripts, margin control, line-spacing
control, and graphics.

Selecting a Printer Control Mode
Your printer has two resident printer control modes:

§ BJ-10 mode, which emulates the IBM Proprinter X24E
§ Epson LQ mode, which emulates the Epson LQ-510 printer

You can select BJ-10 mode or Epson LQ mode with the
DIP switches. BJ-10 modes is the default.
If you were able to select a Canon BJ printer or the IBM
Proprinter X24E through your application program, you
will want to use the printer in BJ-10 mode. This mode gives
you the fullest range of features.
If your application program does not support the Canon BJ
or the IBM Proprinter X24E printers, but does not support
an Epson LQ printer, you can use the printer in LQ mode.
You can also select a printer control mode based on
specific text features you want to use in your document. If
you will be printing only text (no graphics) or printing italic
characters, select LQ mode if Epson drivers are available.
If you plan to print both text and graphics, select BJ-10
mode.

If you will be printing in Windows, use the BJ-200ex printer
driver for all your printing operations (text and graphics). The BJ-
200ex Window driver prints all text graphically.

The following table lists the fonts and pitches that are
available in each printer control mode.

Printer control mode
Typeface BJ mode Epson LQ mode

Prestige 12 cpi
10 cpi, 12cpi, 15 cpi,
17 cpi, 20 cpi, PS

Courier 10 cpi, 12 cpi, 17 cpi, PS
10 cpi, 12cpi, 15 cpi,
17 cpi, 20 cpi, PS

Sans Serif Not available*
10 cpi, 12cpi, 15 cpi,
17 cpi, 20 cpi, PS

Draft (available
in HS mode only)

Not available
10 cpi, 12cpi, 15 cpi,
17 cpi, 20 cpi, PS

Roman Not available
10 cpi, 12cpi, 15 cpi,
17 cpi, 20 cpi, PS
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Script Not available
10 cpi, 12cpi, 15 cpi,
17 cpi, 20 cpi, PS

Orator Not available
10 cpi, 12cpi, 15 cpi,
17 cpi, 20 cpi, PS

Orator-S Not available
10 cpi, 12cpi, 15 cpi,
17 cpi, 20 cpi, PS

* In Epson LQ mode, if you select Sans Serif, the printer
uses the Gothic font.

The following table lists the print styles that are available in
each printer control mode.

Printer control mode
Print style BJ mode Epson LQ mode
Italic No Yes
Emphasized Yes (via ESC E sequence) Yes (via ESC E sequence)
Double-high Yes (via ESC [ @ sequence) Yes (via ESC w sequence)
Double-wide Yes (via ESC W sequence) Yes (via ESC W sequence)
Slashed zero Yes (via ESC [ K sequence) No

To select the printer control mode, use DIP switch 11.
Refer to Chapter 8, Customizing the Printer, for
information on DIP switches.

Setting Up WordPerfect for Your Printer
This section contains the procedures you perform to install
the Bubble Jet Printer BJ-200ex driver for WordPerfect,
version 5.1 or 6.0, for MS-DOS. These instructions assume
you have installed WordPerfect and are familiar with using
it.

1. Make sure your computer is turned on.
2. Make a backup copy of the diskette containing the Canon BJ-

200ex printer drivers for WordPerfect (if you have not already
done so). This is disk 2 of the Windows Driver and Visual
Guide.

3. At the MS-DOS prompt, copy the WordPerfect driver, either
51BJ2E.ALL or 60BJ2E.ALL, to your WordPerfect directory.
For example, if you are using WordPerfect 5.1 and your
directory is WP51, you insert the diskette with the drivers into
drive A and type this command:

COPY A:WP51BJ2E.ALL C:\WP51

If you are using WordPerfect 6.0 and your
directory is wp60, insert the driver diskette
into Drive A and type:

COPY A:QP60BJ2E.ALL C:\WP60

4. Change to the WordPerfect directory and start WordPerfect by
typing WP and pressing Enter.

5. At the document screen, press Shift + F7.
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6. At the Print Options menu, type S to select printer.
7. At the Select Printer menu, type 2.
8. At the additional Printers menu, highlight the BJ-200ex driver

and press Enter.

If you select the BJ-200ex LQ driver, make sure you set DIP
switch 11 to ON for Epson LQ mode. See Chapter 8,
Customizing the Printer, for details.

9. When the printer file name appears at the bottom of the
screen, press Enter.

10. At the printer Helps and Hints menu, press F7.
11. At the printer Edit menu, press F7.
12. At the Select Printer menu, the BJ-200ex driver is highlighted;

type 1 to select the driver.
13. Choose 7 to initialize the printer.
14. At the Print Option menu, make sure the selected printer is BJ-

200ex. Then press F7 to save all selections.

Software and Printer Compatibility
Your software sends information and instructions to the
printer over the cable that connects the printer to the
computer. In addition to data, the instructions you send
may include special command sequences known as control
codes and ESCape sequences. These command sequences
tell the printer such things as how many lines to skip and
where to start printing.

Some control codes are standard throughout the
microcomputer industry and are recognized by all printers.
Two examples of these are form feed (FF) and line feed
(LF).

ESCape sequences are unique to each printer emulation.
ESCape sequences begin with the ESCape character (ESC)
followed by one or more other characters.

The ESCape character tells the printer not to print the next
character (s), but to use the information to perform a
printing control task, such as printing in bold or
underlining.

Most software programs automatically send control codes
and ESCape sequences to the printer. However, some
applications may require you to supply the commands.
How you enter the control codes and ESCape sequences
depends on your software program. Your software program
may require you to enter the codes and sequences in a
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specific format, such as decimal rather than hexadecimal.
For example, you can use only decimal format with
MultiMate Advantage II, Professional Write, and PFS: First
Choice.

Software printer drivers may override the printer control codes
embedded in a document. This means the command will not take
effect because of the way the application handled it.

To determine if an application is overriding your commands, print
the document using a generic driver and see if the correct
commands are reflected in the printed copy. If they are, the
application printer driver is overriding the commands.

If you would like to receive a list of the control codes and
ESCape sequences the printer recognizes, you can use
Canon's toll-free fax retrieval system to request the BJ-
200ex Printer Command Summary. Call 1-800-526-1-800-526-
43454345 for details
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Chapter 5
Using the Operator Panel

This chapter provides information on using the operator
panel located on the top of your printer. You can control
basic printer operations and mechanics through the operator
panel. The indicator lights reflect the currnet status and
modes of the printer.

Most software applications, such as word processing,
spreadsheet, and database programs, automatically handle
the printer control operations. For example, your word
processing program tells the printer what typeface to use,
when to load a sheet of paper or when to perform a line
feed.

If, for some reason, your application program does not
perform these basic functions, you can control them using
the printer's operator panel. You can also select specific
printer functions, such as print mode selection and print
head cleaning.

Any setting you make with your softare application
override settings mad with the operator panel.

In addition to the operations described in this chapter, you
use the operator panel to turn the printer on and off (as
described in Chapter 2, Setting Up the Printer) and to pause
the printer (as described in Chapter 3, Using the Printer.)

Feeding Paper
When the printer is off-line, you can use the LF/FF button
to advance the paper in the printer. You can perform a line
feed or a form feed, or you can eject a sheet of paper.
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Form feeding
If you are loading paper, make sure the printer is off-line.
Press the LF/FF button to load the first sheet of paper to its
top of form. (If you are running a software application, you
don't need to perform this step. The application will tell the
printer when to load paper.)

Line feeding
When a sheet of paper is loaded and the printer is off-line,
press the LF/FF button to advance the paper one line. Press
the button repeatedly to feed many lines.

Ejecting paper
To eject a sheet of paper, make sure the printer is off-line,
then press and hold the LF/FF button for more than one
second. The printer will eject the current sheet of paper.

Selecting a Print Mode
Your printer incorporates two print modes that allow you to
choose between print speed and print quality:

Print mode Function Speed at 10 cpi
HS High speed and draft

quality printing
248 cps

HQ High quality printing 204 cps
Smoothing High quality print with

polished edges

You use the PRINT MODE button to select the current
print mode when the printer is off-line. The default
selection is HQ mode. Pressing the PRINT MODE button
toggles from HQ to HS mode. The HS and HQ lights
indicate which mode is selected.

The print mode may be overriden by your software application.
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Select your print mode as follows:

§ Use HQ mode for most of your printing needs. The printer
automatically prints in HQ mode unless you change the mode
with the PRINT MODE button.

§ Use the smoothing mode when you are printing enlarged
characters with an MS-DOS application. When Smoothing is
enabled, the printer refines your output by polishing away the
jagged edges and ragged stair-stepping curves of the
characters. This results in sharp and crisp print at 720 x 360
dpi. The print speed is slower than HQ mode.

§ Use the HS mode when you are printing draft documents.
Your document will print faster but the print density will be
less than in HQ mode. HS mode uses half the amount of ink as
HQ mode.

Selecting reduction mode cancel Smoothing mode (if set).

Using the Reduction Modes
The printer supports two reduction modes for printing
spreadsheets and other wide documents on regular paper. In
reduction mode, the printer reduces the out put to two-
thirds or one-half of its full size.

Two-thirds Reduction Mode
In two-thirds reduction mode, the printer automatically sets
the print dimensions as follows:

Top Margin: 0.32-inch
Left margin: 0.35-inch
Print width (max): 7.8 inches
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When using reduction mode, you must select the correct
paper size within your application. In the example above,
you would specify a paper size of 11.75 x 16.5 inches in
your application. Be sure to account for your margins.

One-half Reduction Mode
In one-half reduction mode, the printer automatically sets
the print dimensions as follows:

Top margin: 0.12 inch
Left margin: 0.85 inch
Print width (max): 6.8 inches

When using reduction mode, you must select the correct
paper size within your application. In the example above,
you would specify a paper size of 15 x 11 inches in your
application. Be sure to account for your margins.

Selecting the Reduction Mode
We recommend that you use reduction mode with MS-DOS
applications only (not Windows applications). Windows
applications have a fit-to-page feature that is not
compatible with reduction mode.

Before using reduction mode, make sure you set DIP
switch 2 to ON to enable the text scale mode.

To select the reduction mode, follow these steps:

1. Make sure the printer is on-line.
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2. Press and hold the LF/FF button.
3. Press the PRINT MODE button.

§ The printer beeps twice and the indicator for
the current print mode blinks to indicate the
printer is in 2/3 reduction mode.

§ To set the printer in 1/2 reduction mode,
press and hold the LF/FF button and press
the PRINT MODE button again. The
printer beeps three times.

4. Load paper and begin your print operation.

This mode may be overridden by your software.

To disable reduction mode, press and hold the LF/FF
button and press the PRINT MODE button (a third time).
The printer beeps once. When the indicator for the current
print mode (either HQ or HS) is on and not blinking,
reduction mode is cancelled. You can also turn off the
printer.

Selecting reduction mode cancels envelope mode (if set), and
selecting envelope mode cancels reduction mode (if set).

Performing Automatic Line Feeds
You can set the printer so that it performs an automatic line
feed each time it receives a carriage return. Then, when the
printer receives a carriage return code from the computer, it
moves to the beginning of the next line.

You only need to set this function if you are using an
application program that does not include a carriage return
with a line feed.

To set the automatic line feed function, follow these steps:

1. Make sure the printer is turned off.
2. Press and hold the ON LINE, LF/FF, and PRINT MODE

buttons, and then press the POWER button until the beeper
sounds.

If you notice an extra blank line between each line printed,
be sure to cancel this function.
To cancel the automatic line feed function, turn off the
printer.
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Chapter 6
Maintaining the Printer

This chapter covers the care and maintenance of your
Canon Bubble Jet Printer BJ-200ex. This includes
guidelines, cleaning the printer, replacing the ink cartridge,
and transporting the printer.

Printer Guidelines
Follow these guidelines to avoid damage to your printer
and harm to you or others:

§ Set the printer on a stable surface. Do not use an angled printer
stand.

§ Keep the front cover closed when printing.
§ Do not set anything on top of the printer.
§ Always use a three-wire, grounded power receptacle

(electrical wall outlet with three holes) for your printer's power
cord. Do not modify the cord to remove the ground pin.

§ Make sure the power is off any time you connect or disconnect
the power cord or interface cable.

§ Do not move the mechanism that holds the ink cartridge. You
may damage delicate mechanical parts.

§ Do not touch the print area on the ink cartridge. If the ink
spills, it is difficult to clean.

Cleaning the Printer
Your printer requires little routine maintenance. Perform
the following maintenance, as necessary, to keep your
printer in good operating condition.
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Be very careful when cleaning the printer. Follow these
steps:

1. Make sure the printer is turned off; then unplug it.
2. Clean the platen and its surrounding area inside the

printer.
§ Use a soft cloth to remove any ink mist or

paper debris.
§ Do not use any oil or cleanser inside the

printer.
§ When cleaning inside the printer, avoid the

area near the print head on the ink cartridge.
Do not touch the print head. Ink may leak
out and cause stains.

§ Do not use paper products (such as paper
towels or tissues) to clean the inside of the
printer. They may leave paper particles
inside the printer.

3. Clean the exterior of the printer.

§ Use a soft cloth moistened with water.
§ Clean any smudges or dust.
§ Do not clean the exterior of the printer with

volatile liquids such as thinners, benzine, or
any spray type or chemical cleaners; doing
so will damage the surface of the printer.

§ Do not submerge the printer in water.

Replacing the Ink Cartridge
You use the BC-02 ink cartridge with this printer. Each ink
cartridge can print about 400 to 500 letter-size pages
(700,000 characters) in HQ mode and 800 to 1000 pages
(1,400,000 characters) in HS mode. The actual amount
varies according to the print density of a page. If you print
a lot of graphics, you may to need to change cartridges
more often.
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You may need to replace the ink cartridge when the
following condition exist:

§ You have been using the cartridge for over one year.
§ Your printed output is not crisp and clear, or there are gaps in

the characters (missing dots).
§ Your output has no ink on it.

If your print quality is not crisp and clear, see Chapter 7,
Troubleshooting, for possible solutions. If the problem
seems to be your ink cartridge, be sure to clean the print
head before determining that you need to replace the
cartridge, be sure to clean the print head before determining
that you need to replace the cartridge. If you clean the print
head several times and your print quality does not improve,
you need to replace the cartridge. (The print head cleaning
procedure is described later in this chapter.)

Print head cleaning is not a routine maintenance procedure. Only
clean the print head if your print quality is inadequate.

The Bubble Jet Printer BJ-200ex was designed to be used
exclusively with Canon ink cartridges. Other inks may damage
the print head capping and cleaning devices in the printer. If you
have problems that are caused by using third-party ink or ink
cartridges, your warranty will be void.

Ink Cartridge Guidelines
To avoid spilling ink, follow these precautions:

§ Do not attempt to disassemble or refill the ink cartridge.
§ Do not vigorously shake the ink cartridge while handling it.
§ Do not unpack an ink cartridge until you are ready to install it.
§ Do not remove the ink cartridge unless you need to replace it.
§ Do not touch the print head on the ink cartridge or the sharp

edges around it.
§ Do not hold the ink catridge, or place it on a table, with the

print head facing down, (except when you are installing it).

If spilled, the ink is difficult to clean. Therefore, it's a good idea to
keep the ink cartridges out of children's reach.

Using Ink
Ink formulation is the most critical component of a Bubble
Jet printer. The ink you use must meet these guidelines:
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§ It must be able to be heated and cooled over 6,000 times per
second without clogging.

§ It must dry very quickly without bleeding into other colors.
§ It must work with different media and software, while

providing correct color matching with the printer driver.
§ It must be environmentally friendly.

Canon has more engineers dedicated to providing the best
results for output on Bubble Jet pritner than any other
organization. Canon does not dissuade you from using ink
made by third-party suppliers. However, we specifically
design and warranty our products for our inks only.
Canon cannot guarantee the quality or performance of your
printer when you are using inks from other suppliers. In
addition, if a problem emerges as a result of using ink from
a supplier other than Canon, your warranty will be invalid.
For optimum printing results, use only the Canon BC-02
ink cartridge.

Installing the Ink Cartridge

Canon makes numerous ink cartridges; the BC-02 cartridge is
designed specifically for the BJ-200ex Bubble Jet Printer and is
the only one you should use.

To install a new ink cartridge, follow these steps:

1. Make sure the printer is turned off.
2. Open the front cover.
3. Lift the green lock lever on the cartridge holder.

§ Slide the old ink cartridge out of the holder
and dispose of it properly.
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4. Take the new ink cartridge out of its protective packaging.

§ Slide off the orange protective cap from the
print head and then remove the orange tape.

Install the ink cartridge immediately after removing it from its
protective packaging.

5. Fit the ink cartridge over the yellow mounting base with
the print head facing down.

§ When installed correctly, the label on the
cartridge will be upside down.
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Avoid touching the yellow mounting base on which you place the
cartridge--especially the circuit board on the side of the mounting
base and the film cable that extends from the catridge holder.

6. Push the lock lever down until it locks into place.

§ Use one hand only to set the cartridge in
place and press the lock lever down

§ Make sure there is no resistance when you
press on the lock lever. The lever should
lock easily into place.

§ If you hear snapping noises or feel any
resistance as you press down on the lever,
remove the ink cartridge and try again.

7. Be sure no gap exists between the ink cartridge and
cartridge holder.

§ When secure, the ink cartridge makes
contact with the circuit board inside the
cartridge holder.
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Do not move the ink cartridge after installing it. Moving the ink
cartridge to the left and leaving it there may uncap the print head
and cause it to dry out.

8. Close the front cover.

When you are not using the printer, make sure the ink
cartridge is in its home position, which is on the right side
of the printer.

Always use the POWER button to turn off the printer. This
ensures that the printer moves the print head to the home position
and caps it.

Cleaning the Print Head
The print head on a new ink cartridge needs to be cleaned
to ensure the best possible print quality. The printer
automatically cleans the print head when you follow these
steps:

1. Make sure the printer is turned on and on-line.
2. Press the ON LINE and PRINT MODE buttons at the

same time.
§ When the ON LINE light starts to blink,

release the buttons.

The ON LINE indicator will blink for about 12 seconds
while the printer cleans the print head. When complete, the
ON LINE indicator stops blinking and goes off. Press ON
LINE to resume printing.

Cleaning the print head consumes a small amount of ink.
Repeating this procedure unnecessarily reduces the life of the
cartridge.
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Storing Ink Cartridges
Follow these guidelines when storing your ink cartridges:

§ Keep a new ink cartridge in its sealed container until you are
ready to use it.

§ Store the ink cartridge at room temperature.
§ Install the ink cartridge in the printer immediately after you

open the sealed container.
§ After installing the ink cartridge, perform the print head

cleaning procedure.

Ink Cartridges Continually Run Out of Ink
If your ink cartridges seem to run out of ink before you
think they should, make sure you are following these
guidelines:

§ Make sure you turn off the printer only when the ink cartridge
is in the home position.

§ Only transport the printer when the ink cartridge is in the
home position. This caps the ink cartridge and prevents it from
damage or drying out. Be sure to tape the ink cartridge in
place.

This is not a portable printer. Take care when transporting it.

§ Install an ink cartridge immediately after opening its
protective packaging.

§ Only clean the print head when you are having print quality
problems.

§ Never unplug the printer or use a power strip to turn off the
printer when the printer's power is turned on.

Transporting the Printer

While the Bubble Jet Printer BJ-200e is small and compact, it is
not a portable printer and you need to take care when transporting
it. The printer's components, such as the sheet feeder, may become
damaged if subjected to severe vibration during transportation.
Also, your print head may dry out during travel (and become
unusable) it it is not capped correctly.

If you plan to move the printer from one location to
another, or if you want to store it, follow these steps:

1. Press the POWER button to turn off the printer. This
moves the print head to the home position.

2. Remove any paper from the sheet feeder.
3. Detach the interface cable and the power cord.
4. Open the front cover.
5. Tape the ink cartridge to the side of the printer.
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6. Close the front cover.

7. Return the paper rest and paper exit support to their
original positions.

8. Repack the printer in its original packing materials.

Do not remove the ink cartridge from the printer or ship an ink
cartridge from which you have removed the protective cap. An
opened ink cartridge that is not installed in the printer may leak,
and the print head may dry out. Also, if you do not tape the ink
cartridge to the side of the printer, ink may spill into the printer.
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Chapter 7
Troubleshooting

This chapter contains information to help you solve printer
problems. A problem may have one or a combination of
causes, including a malfunction in your computer, software,
the printer cable, or the printer. Many printing problems are
related to how your software interacts with the printer.

If you can print a self test but the printer does not print or
your printed output is not what you expect, the problem is
with your computer, software, or cables. Check these items
for a problem.

If your printer is not operating properly, try the suggestions
in this chapter. Try the solutions in the order listed. The
following list shows the problems covered here.

Check List
ERROR Light Problems

 
ERROR light is on
ERROR light is on - ON LINE, HQ, and HS lights are blinking

Operational Problems
No power reaching printer
Data from computer in not printed
Ink cartridge moves, ink does not appear
Overall printing is slow from MS-DOS
Overall printing is slow from Windows

Printing Problems
Data from computer printed, but is not what you expected
Printed characters do not match characters on the screen
Printing Beyond Edge of Page
Printout Does Not Match Paper Size
Printing Incorrect Number of Lines on Page
Printer is not using font you selected with DIP switch settings
Printout curls
Computer Indicates a Device Time-out

Paper Loading Problems
Paper is Loaded Skewed (Printing Is Skewed)
Paper Does Not Load Into Printer
Multiple Sheets Load Into Printer
Envelopes Do Not Load
Paper Does Not Eject After Printing
Repeated Paper Jams Occur

Print Quality Problems
Print Density Is Low
Print Is Not Clear
White Streaks or Missing Dots
Blurred or Smudged Ink
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Splashed dots
Paper edge is soiled with ink
Output Appears Jagged

Windows Problems
Printer does Not Print or Prints Garbage
Printer does not print from Windows (but does print from MS-DOS)
Output is not as Expected
Extra Characters Appear on the Page
Fonts do not Print as Smoothly Rounded Characters
Cannot Print File sent from Remote Computer
Large Gaps appear Between Text or Graphics
Error occurs during Visual Guide Installation
Control Array Error occurs when Installing the Visual Guide
Print Manager Problem Occurs
In WordPerfect, the BOX prints but the text does not

Clearing Paper Jams

If you have a problem with your printer and you cannot
resolve it by referring to the information in this chapter,
contact the Canon help desk at 1-800-423-23661-800-423-2366 (U.S.A.)
or 1-800-263-11211-800-263-1121 (Canada). The staff at the help desk is
trained in the technical support of Canon's products and
should be able to help you with your problem. If your
printer requires service, the staff at the help desk can
provide you with the telephone number of your local Canon
Authorized Service Facility (ASF).

Attempting to repair the printer yourself may void the warranty.

Before contacting Canon, make sure you know the
following information:

§ Product name
§ Serial number
§ Place of purchase
§ Nature of problem
§ Steps you have taken to solve the problem and the results.

The serial number is located on the label on the back of the
printer:

ERROR Light Problems
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The following table describes problems and solutions
related to the ERROR light.

Problem Cause Solution
ERROR light is on The printer may be

out of Paper.
Check the sheet feeder. If the printer is out of paper, load
paper into the sheet feeder and press the ON LINE button
to continue printing.

Paper may be
jammed in the
printer.

Check the pirnter for a paper jam. If a paper jam has
occured, clear it as described later in the chapter. (See the
clearing Paper Jams section)

ERROR light is on - ON
LINE, HQ, and HS lights are
blinking

A system error
may have occured.

Turn the printer off; wait 15 seconds and turn the printer
back on.

If the error persists, call the Canon help desk.

Operational Problems
If you are having problems with the printer, check the
problems and solutions listed in the following table.

Problem Cause Solution
No power
reaching printer.

The printer may not be
turned on.

Hold down the POWER printer button until the printer beeps.

The printer may not be
securely plugged into the
AC outlet.

Check the AC power cord connection.

The AC outlet may not be
supplying power.

Check the AC outlet.

Turn on the printer. When the printer is connected
properly, the POWER, ON LINE, and HQ (or HS)
indicators light, and the print head is in the home
position. If nothing happens, call the Canon help
desk.

Data from
computer is not
printed.

The printer may be off line
(ON LINE light off).

Press the ON LINE button to turn the printer on line (ON
LINE light is on). If the printer does not come on line, check
the ERROR light.

The interface cable may not
be securely connected to
the printer and the
computer.

Check the interface cable connection.

The interface cable may not
be the correct type.

Make sure the interface cable is a parallel interface cable.

The printer or computer
may have been turned on
when you connected the
interface cable.

Turn off the printer and the computer, then turn them back on
again.

The application may not be
set up properly.

Check the computer or the application to see if the host is
configured correctly: printer port, printer driver, print
manager.

The parallel port is disabled
in your computer's CMOS
memory.

Check your computer's CMOS to see if the primary parallel
port is set to LPT1. (Your computer should have a setup
program that allows you to check the CMOS settings.)

Ink cartridge
moves, ink does
not appear.

The ink cartridge may be
empty or may not be
installed properly.

Remove the ink cartridge and check that the tape is removed.

Reinstall the ink cartridge checking that it is
securely latched in place. Make sure there is no gap
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between the ink cartridge and the holder.

Perform the print head cleaning procedure
described in Chapter 6, Maintaining the Printer.

If cleaning the print head does not resolve the
problem, your ink cartridge my be out of ink.
Replace the ink cartridge and try printing again.

Overall printing
is slow from
MS-DOS.

Smoothing mode may be
enabled.

Disable the Smoothing mode.

High Quality mode may be
enabled.

Try turning off HQ mode via the operator panel.

Overall printing
is slow from
Windows.

The Print Manager my be
turned on.

Make sure the Print Manager is turned off.

Print options may be too
complex.

In the Windows driver or your software application, set all
print options to their defaults.

See page 75 for ways to improve speed.

Printing Problems
If you are having printing problems, check the problems
and solutions in the following table.

Problem Cause Solution
Data from
computer
printed, but is
not what you
expected.

There may be a communication
problem between the printer and
your computer.

Check the computer or the application to see if the
host is configured correctly: printer port, printer
driver, print manager.

Cable connections may not be
secure.

Check that your cable connections are secure.

NOTENOTE: Make sure your interface cable is no
longer than 6.6 feet. Avoid useing A/B
switch boxes or switch boxes that have a
total cable length of more than 6.6 feet.

Printer control mode may not
match the printer device.

Check that the printer control mode (BJ-10 or Epson
LQ) matches the printer driver you selected.

Previous software settings may not
be cleared.

Check that the printer was cleared of the previous
software settings before the print job started.

Printed
characters do not
match characters
on the screen.

Many graphics characters and
special symbols are produced by
different ASCII codes according to
the type of printer and computer
being used.

Set the correct character table and printer control
mode using the printer's DIP switches. For details on
character sets, contact the Canon fax retrieval system
and request the BJ-200ex Printer Command
Summary.

Printing beyond
edge of page.

Paper may not be aligned correctly
in sheet feeder.

Make sure the paper is aligned correctly in the sheet
feeder.

Software settings may be
incorrect.

Check the software setting for the right margin.

DIP switch 1 may be set
incorrectly.

Check the setting of DIP switch 1. This DIP switch
controls the horizontal print position:

§ For Letter size paper, set it to OFF.
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§ For envelopes, set it to OFF.

§ For A4 size paper, set it to ON.

Printout does not
match paper size.

Paper size selected in driver may
be incorrect.

Make sure the paper size you select within your
printer driver matches the oreientation in which you
load the paper in the printer.

Paper width selected in driver may
be incorrect.

Make sure the width of the paper on which you are
printing matches the width defined by your software
so the paper is always between the print head unit and
the platen.

NOTENOTE: If the print head unit does print on
the platen, wipe it clean with a dry cloth.
Also, feed a few sheets of paper through the
printer to clean the ink off the platen.

Printing
incorrect number
of lines on page.

DIP switch 3 may be set
incorrecty.

Check the setting of DIP switch 3. This DIP switch
determines the page length:

§ For letter size paper, set it to OFF

§ For envelopes set it to OFF.

§ For A4 size paper set it to ON.

Margin settings may be incorrect. Check the top and bottom margin settings within your
software application.

Paper may not be loaded properly. Make sure your paper is loaded correctly.
NOTE: If your application requires 66 lines
per page, try setting DIP switch 2 to ON.
This enables text scale mode. See Chapter 8,
Customizing the Printer, for details on the
DIP switches.

Printer is not
using font you
selected with
DIP switch
settings.

Your software may be overriding
the settings.

Change the initialization or setup string that your
software sends. You may need to do this using a
menu or scrren provided by your application
software. See your application user's manual for
information about how your software works with
your printer.

Printout curls. Your page may include a dense
amount of ink.

Remove the printout immediately and let it dry, then
roll it in the direction opposite to the curl.

Computer
indicates device
time out.

A device time out occurs when
your computer sends data to the
printer but the printer does not
respond. The printer may be off,
off line, or not connected to the
computer.

Make sure the printer is turned on and on line.
Check that the printer's interface cable is
securely attached to both the printer and the
computer.
Make sure paper is properly loaded in the
sheet feeder.
Try the print operation again.
If you want your computer to continuously
retry sending data to the printer's parallel
port, add the following statement to your
AUTOEXEC.BAT file:

MODE LPT1,,P

Paper Loading Problems
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If you are having paper loading problems, check the
problems and solutions in the following table. After solving
a paper loading problem, remove the paper and load it
correctly. Then press the ON LINE button to set the printer
on line again.

Any of the following paper loading problems may cause
the paper to jam in the printer. See page 123 for complete
instructions on how to clear a paper jam.

Problem Cause Solution
Paper is loaded
skewed (printing is
skewed)

Paper may not be stacked
correctly in sheet feeder.

Make sure the stack of paper is straight in the sheet feeder.

Check that the paper rest is extended and the
paper selection lever is back.

Make sure the right side of the stack of paper is
aligned against the right side of the sheet feeder
and the left side is aligned against the paper
guide.

Make sure the paper exit path is clear.

Paper does not
load into printer.

Paper selection lever may
not be seated correctly.

Make sure the paper selection lever is set to the correct
position:

§ For automatic loading of plain paper, set it to the
back.

§ For automatic loading of envelopes, set it to the
front.

§ For manually feeding paper, set it to the front.

§ For transparencies or thick paper, set it to the
front.

Single sheets may not be
feeding correctly.

When manually loading paper, be sure to insert a single
sheet of paper all the way into the sheet feeder. If the
paper is not inserted far enough, the printer cannot load it.

Multiple sheets
load into printer

Sheets of paper may be
sticking toghether.

Make sure the paper is not sticking together. Be sure to fan
the stack of paper before placing it in the sheet feeder.

Paper selection lever may
not be set correctly.

Check that the paper selection lever is back for automatic
loading of paper.

Too much paper may be
stacked in sheet feeder.

Make sure the stack of paper does not exceed the paper
limit mark on the right side of the sheet feeder. If
necessary, remove a few sheets from the sheet feeder.

Different types of paper
may be stacked in sheet
feeder.

Load just one type of paper.
Do not use curled or bent paper, which may fall
into the manual feed slot and cause the paper to
misfeed.
Make sure you are laoding paper that matches
the specifications of this printer. See Appendix
A, Specifications, for details.

Envelopes do not
load

Paper selection lever may
not be set correctly.

Make sure the paper selection lever is set to the front
position.
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Envelopes may not be
loaded correctly.

Make sure the envelopes are loaded properly:

§ The top of the envelope goes in first.

§ The flap is toward the sheet feeder.
§ The right side of the envelope is aligned against

the right side of the sheet feeder.
§ The left side is aligned against the paper guide.

(See Chapter 3, Using the Printer, for details)
Single envelopes may not
be feeding correctly.

For manual loading, make sure the envelope mode in your
printer driver or your software application. If necessary,
enable envelope mode using the printer's operator panel.

Envelope mode may not be
enabled.

Make sure you have set up envelope mode in your printer
driver or your software application. If necessary, enable
envelope mode using the printer's operator panel.

NOTENOTE: Use only commercial number 10
envelopes, which are 9.5 x 4.1 inches.

Paper does not
eject after printing

Your software application is
not telling the printer to
eject the paper after
printing.

Press the ON LINE button to set the printer off line.
Press and hold the LF/FF button for one second
to eject the paper.
To resume printing, press the ON LINE button.

Repeated paper
jams occur

The paper you are using
may be causing the jams.

Fan the paper before stacking it in the sheet feeder. This
keeps the sheets of paper from sticking together.
Check that the paper you are using and your
printing environment are within the
specifications of the printer. See Appendix A,
Specifications, for details.
To clear paper jams, see page 123.

Print Quality Problems
If your print quality is not what you expect it to be, check
the problems and solutions listed in the following table.

Problem Cause Solution
Print density
is low

You are using HS mode and not
getting satisfactory darkness.

Try HQ mode; the print density in HQ mode is higher
than HS mode.

Print is not
clear

You are printing on the wrong
side of the paper.

Paper has a right side for printing. If the print quality is
not as clear as you would like it to be, try turning the
paper over and printing on the other side.

Paper thickness lever may be set
for the wrong type of paper.

Make sure the paper thicknes lever (inside the printer) is
set for your paper type.

The paper you are using may not
be supported by the printer.

Make sure you are using the recommended paper. See
Appendix A, Specificaitons, for paper specifications.

The print head may need to be
cleaned.

Clean the print head. See Chapter 6, Maintaining the
Printer, for details.

You are not using a BC-02 ink
cartridge.

Make sure you are using a BC-02 ink cartridge. If not,
replace the ink cartridge with a BC-02.

White streaks
or missing
dots

Ink nozzles on the print head may
be clogged with dust.

Clean the print head. See Chapter 6, Maintaining the
Printer, for details. Repeat cleaning if necessary.

The ink cartridge may be installed
incorrectly.

Make sure the ink cartridge is installed correctly.

The print medium being used may
not be acceptable.

Use only print media specified in the Selecting Paper
Types section on page 35.
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The print resolution set in the
printer driver may be 180 dpi and
the printer print mode may be HS
mode.

When printing in Epson LQ mode, printing at 180 dpi in
HS mode may cause white streaks. To remedy, select the
HQ mode with the printer control panel.

The print head may be worn out. If the print head has expired, contact your local Canon
authorized dealer and replace it with a new one.

Blurred or
smudged ink

The sleected print mode may not
match your needs.

Select the print mode most suitable for your needs.
When printing through the Canon BJ-200ex printer
driver for Windows, select the suitable print mode from
the printer driver dialog box.

The print medium being used may
not be acceptable.

Use only print media specified in Selecting Paper Types
on Page 35.

The paper thickness lever may not
be set correctly.

Make sure the lever is left for plain paper, or
transparencies. Set it to the right for thick paper or
envelopes.

You may be printing on the
wrong side of the sheet.

Paper has a right side for printing. If the print quality is
not as clear as you would like, try turning the paper over
and printing on the other side.

You are not using a BC-02 ink
cartridge.

Make sure you are using a BC-02 ink cartridge. If not,
replace the ink cartridge with a BC-02.

Splashed dots Ink nozzles on the print head may
be clogged with ink.

Clean the print head. See Chapter 6, Maintaining the
Printer, for details. Repeat cleaning if necessary.

The paper thickness lever may not
be set correctly.

Make sure the lever is left for plain paper and
transparencies, or right for thick paper or envelopes.

Paper edge is
soiled with ink

The platen in the printer may be
soiled with ink.

Clean the platen with a soft cloth (see chapter 6,
Maintaining the Printer, for details).

Feed a few sheets of paper through the printer.

The resolution selected via printer
driver may be 180 dpi.

Check your software application to see what printing
resolution you have selected.

Printing at 180 dpi will give the output a
jagged look. Changing the resolution to 360 dpi
should correct this problem.

Output
appears jagged

Try using the Smoothing mode. If you are printing double height or double width
characters or graphics containing a lot of diagonal lines,
use the Smoothing mode.

Windows Problems
The following table contains problems and solutions related
to using your printer with Windows applications.

Problem Cause Solution
Printer does not
print or prints
garbage.

Cable connections may
not be secure.

Check that the cable and power cord connections are secure.

Printer may not be turned
on.

Turn on the printer.

Printer driver may not be
set up.

Make sure the printer driver is properly installed and set up.
See Chapter 4, Using the Printer With Your Software, for
details.

Print Manager may be
causing the problem.

Check Print Manager for stalled print jobs caused by printer
not being ready to accept data. Delete all stalled jobs, make
sure printer is on line, and try to print again. If errors
continue, turn off Print Manager.
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Printer does not
print from
Windows (but
does print from
MS-DOS)

Your computer is having
a problem communicating
with the printer.

Follow these steps:

1. Select the Main group from the Program Manager.

2. Double Click on the Control Panel.
3. Double Click on the Printer icon.
4. Select the BJ-200ex.
5. Click on Connect.
6. Click on the box next to Fast Printing Direct to Port

to remove the X.
7. Click on OK.
8. Click on Close.
9. Close the Control Panel.
10. Try your print operation again.

If problem persists, go back to step 5 (above) and
change the connection from LPT1 to LPT1.DOS.

Output is not as
expected

Printer driver may not be
correct.

Make sure you have selected the Canon BJ-200ex setting in
the Printer dialog box or from the printer setting for your
particular application.

Extra characters
appear on page

Print Manager may be
causing problems.

Disable the Print Manager.
If the image prints correctly with the Print Manger
disabled, but you want to use the Print Manger to
print in Windows, try the following:

1. Minimize all the current Windows applications.

2. Click on Print Manager; a dialog box appears.
3. Select END TASK.
4. Double Click on Program Manger.
5. Select WINDOW
6. Select MAIN
7. Double Click on Control Panel.
8. Double Click on Printers
9. Place and X in the box next to Print Manager.
10. Select the Canon BJ-200ex
11. Select CONNECT
12. Change the value in Device Time outs from 15 to 30

seconds.

13. Change the value in Transmission Retry from 45 to
90 seconds.

Fonts do not print
as smoothly
rounded
characters

Bitmapped fonts designed
for dot matrix printers do
not print smoothly
rounded characters when
used with high resolution
printers like the BJ-
200ex.

Make sure you installed an outline font manager, such as
Adobe Type Manager or Bitstream Facelift, or that you are
choosing a TrueType font.

Certain MS fonts, such as
MS Serif, will print
jagged.

Choose another font.

Cannot print file
sent from remote
computer

Software may not be
configured correctly.

Check that all software is correctly configured for the
network environment. For example, with a Novell network
you must include the Capture statement. Refer to the user's
manual supplied with your networking software for more
information.

Large gaps appear Check that the video Choose the Main group icon in the Program Manger and open
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between text or
graphics

driver is VGA. the Windows Setup icon. If the display driver is anything
other than VGA, call the display manufacturer and request an
updated display driver. In the meantime, install the standard
VGA driver that came with Windows 3.1.

Automatic line feed may
be enabled.

Make sure automatic line feed is disabled through the DIP
switches. See Chapter 8, Customizing the Printer, for details.

Error occurs
during Visual
Guide installation

One or more visual basic
applications are running.

Follow these steps:

1. In Windows, press and hold Ctrl and press Esc. A
task list dialog box appears.

2. Highlight each task except Program Manager and
select End Task.

3. Now try to install the Visual Guide (see page 28).

DDEML.DLL file is out
of date.

Follow these steps:

1. In Windows, select the MAIN icon.

2. Double Click on File Manager.
3. Select File and then search.
4. Type: DDEML.DLL
5. In the Start From line, type C:\ and click OK.
6. Delete all occurrances of DDELM.DLL.

7. Now try to install the Visual Guide (see page 28).

Control Array
error occurs when
installing the
Visual Guide

THREED.VBX file is
causing a conflict with
the new files.

If you are using MS-DOS 6.x or later, type the following
command at the C:\ prompt:
MOVE C:\WINDOWS\SYSTEM\THREED.VBX
C:\WINDOWS

If you are using MS-DOS 5.x or lower, type the
following:
COPY C:\WINDOWS\SYSTEM\THREED.VBX
C:\WINDOWS
DEL C:\WINDOWS\SYSTEM\THREED.VBX

Print Manger
Problems occur

The drive that contains
the SET TEMP directory
may not have enough
available space.

Canon recommends that the drive have from 5 MB to 10 MB
available.
To verify a proper SET TEMP statement, follow
these steps:

1. Exit Windows and go to the MS-DOS prompt.

2. Type SET at the MS-DOS prompt. A list of
statements should appear; look for the statement that
says

SET TEMP = C:\WINDOWS
3. If this statement exists, verify that the directory

exists by typing in the drive and directory location
with the DIR command. For example:

DIR C:\WINDOWS
4. If the FILE NOT FOUND messge appears, then one

of the following has occured:
§ The path was typed in incorrectly;

simply type the path correctly.

§ The directory does not exist; edit
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the AUTOEXEC.BAT file and
change the directory to a valid
directory; for example:
SET TEMP = C:\DOS

In WordPerfect,
the BOX prints
but the text does
not

The Fast Graphic Printing
option needs to be
enabled (5.2) or disabled
(5.1).

If you are in WordPerfect 5.1 for Windows and the BOX
prints but your text does not print, follow these steps:

1. Select File

2. Select Preferences
3. Uncheck the Fast Graphic Printing option for the

Windows Printer Driver.
If you are in WordPerfect 5.2 for Windows, and the
BOX prints but your text does not print, follow
these steps:

1. Select File

2. Select Preferences

3. Check the Fast Graphic Printing option for the
Windows Printer Driver

Clearing Paper Jams
When a paper jam occurs, the ERROR light comes on and
the printer goes off-line.

Clear the paper jam as follows:

1. Press the POWER button to turn off the printer.
2. Gently pull the paper out with one hand while holding down

the printer with the other hand.

3. If the paper tears off inside the printer, open the front cover
and remove the paper left inside the printer.
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4. Press the POWER button to turn the printer back on. The
POWER, ON LINE, and HQ (or HS or SMOOTHING) lights
come on and the print head moves to the home position. The
printer is now ready for printing.

If you are printing high density graphics when a paper jam
occurs, feed at least two sheets of paper through the printer
to clean the rollers.
If the platen is soiled, wipe it clean with a dry cloth.
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Chapter 8
Customizing the Printer

This chapter describes the factory default settings of the printer and the steps you
follow to customize these settings for your particular printing needs.

You will find that the factory default settings provide features to meet most of
your printing needs. With these settings, your printer emulates any Canon BJ
printer and the IBM Proprinter X24E. This means you can use the printer with
any software application that supports these printers.

Make sure the printer's settings match the requirements of your software
application. If you have a unique printing requirement, you can customize the
printer by changing the DIP switch settings as described in this chapter.

Your printer defaults to BJ-10 mode and provides numerous printing features in
this mode. If your software application is designed to print only on an Epson LQ
printer, you can use the DIP switches to change the printer control mode to Epson
LQ.

You can also enable automatic emulation switching, which allows the printer to
switch between BJ-10 mode and Epson LQ mode.

The DIP switches are located under the cover on the left side of the printer.

 

Factory Default Settings
The following table shows the factory default settings of the printer:

Function Setting
Printer control mode BJ-10
Character Pitch 10 characters per inch (cpi)
Line spacing 6 lines per inch (lpi)
Print quality High quality (HQ) mode
Beeper Enabled
Automatic carriage return (CR) Disabled (no CR with line feed)
Automatic line feed (LF) Disabled (no automatic LF after CR)
Slashed zero Disabled (zero not slashed)
Vertical tab stops No vertical tabs set
Horizontal tab stops Column 9 (then every 8th column)
Vertical margins Top margin = first print line

Bottom margin = page length
Horizontal margins Left margin = 0

Right margin = maximum print width
Page length 11 inches
Horizontal print position Letter
Print direction Bi-directional
Font typeface Courier
Character set Character Set 1
Code page 437 (IBM USA)
Buffer Input = Approx. 41.2 KB

Download = 0 KB
Text scale mode Disabled
Envelope mode Disabled
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Smoothing mode Disabled
Reduction mode Disabled
Alternate Graphics Mode Disabled
Automatic emulation switching mode Disabled

The default setting is BJ-10 mode. If you change this to Epson LQ mode, the default
settings also change.

DIP Switch Settings
The DIP switch settings control various printer functions, such as the page length
and character set you want to use. The printer functions defined by the DIP
switches are determined by the printer control mode. The printer has two control
modes:

§ BJ-10 mode, which emulates the IBM Proprinter X24E
§ Epson LQ mode, which emulates the Epson LQ printers

DIP switch 11 selects the printer control mode. When DIP switch 11 is OFF, the
printer is in BJ mode (this is the default). When DIP switch 11 is ON, the printer
is in Epson LQ mode.

BJ-10 Mode

When the printer is in BJ-10 mode (DIP switch 11 is OFF), you can set the DIP
switches to control the following functions:

DIP switch Function OFF ON
1 Horizontal print

position
Letter size or
envelope

A4 size

2 Text scale mode Disabled Enabled
3 Page length 11 inches Disabled
4 Character set Set 1 Set 2
5, 6, 7 Code page See following descriptions
8 Automatic carriage return (CR) Line feed (LF only) LF with CR
9 Alternate Graphics Mode (AGM) Disabled Enabled

10 Buffer size
Input: 62 KB
Download: 0 KB

Input: 21 KB
Download: 41 KB

11 Printer control mode BJ-10 mode Epson LQ mode
12 Automatic emulation switching Disabled Enabled

DIP switch 1DIP switch 1
Use this switch to change the horizontal print position according to the size of
your paper. If you are using letter-size paper or COM 10 envelopes, set this
switch OFF; the left margin will be 0.25 inch (6.4). If you are using A4-size paper
or DL-size envelopes, set this switch ON; the left margin will be 0.13 inch (3.4
mm).

DIP switch 2DIP switch 2
If you are using a software application that assumes 66 lines will fit on each page,
set this switch to ON. The printer will reduce the line spacing by a factor of 14/15,
which is from 62 lines per page to 66 lines per page if line spacing is set to 6 lines
per inch (lpi).

DIP switch 3DIP switch 3
If you are using letter-size paper, set this switch OFF; this sets the page length to
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11 inches. If you are using A4-size paper, set this switch ON; this sets the page
length to 12 inches.

DIP switch 4DIP switch 4
When this switch is OFF, the printer uses Character Set 1. When this switch is
ON; the printer uses Charater Set 2.

DIP switches 5, 6, 7DIP switches 5, 6, 7
These switches allow you to select the following code page tables.

DIP switches
Character set 5 6 7
437 (USA) OFF OFF OFF
850 (Multilingual) OFF OFF ON
850 (Multilingual) OFF ON OFF
850 (Multilingual) ON OFF ON
850 (Multilingual) ON ON OFF
860 (Portuguese) ON ON ON
863 (French Canadian) OFF ON ON
865 (Norwegian) ON OFF OFF

To see the samples of the character sets available with each code page table, use
Canon's toll-free fax retrieval system. Call the Canon help desk and request the
fax retrieval system; then request the BJ-200ex Printer Command Summary.

DIP switch 8DIP switch 8
When this switch is OFF, the printer performs a normal line feed. Set this to ON if
you want the printer to perform a carriage return after each line feed (LF + CR).

DIP switch 9DIP switch 9
Set this switch ON to enable Alternate Graphics Mode (AGM). In this mode, the
printer accepts high-resolution, 24-dot, all-points-addressable (APA) graphics
commands similar to those used with conventional 24-pin printers.

DIP switch 10DIP switch 10
When this switch is OFF, the printer allocates the entire buffer space (62 KB) to
the input buffer. When you are using downloaded fonts, change this switch to
ON; the printer will allocate 41 KB of buffer space for downloaded fonts.

DIP switch 11DIP switch 11
When this switch is OFF, the printer is in BJ-10 mode. When this switch is ON,
the printer is in Epson LQ mode.

DIP switch 12DIP switch 12
Set this switch ON to enable automatic emulation switching mode. In this mode,
the priter detects whether the codes being sent are BJ-10 mode or Epson LQ
mode. It then selects the printer control mode to match the printer driver selected
in the MS-DOS application.

When DIP switch 12 is OFF, the printer control mode is set by DIP switch 11
(OFF selects BJ-10 mode, ON selects Epson LQ mode).

Automatic emulation mode is applicable for MS-DOS applications only. When
you are using Windows, the BJ-200ex printer driver for Windows selects the
appropriate control mode regardless of the settings of DIP switches 11 and 12.
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Setting DIP switch 12 ON reduces the input buffer by 21 KB.

When using Windows, set DIP switches 10, 11 and 12 OFF to maximize the size
of your input buffer (62 KB).

§ If the printer does not seem to be switching between BJ-10 and Epson LQ mode, disable this
function and set DIP switch 11 to match your application's printer driver.

§ If you are using a printer switching device, you must allow at least ten seconds for the printer
to recognize an emulation change. If your printer switching device switched data in less than
ten seconds, automatic emulation switching will not function properly.

Epson LQ Mode
When the printer is in Epson LQ mode (DIP switch 11 is ON), you can set the
DIP switches to control the following functions:

DIP switch Function OFF ON
1 Horizontal print

position
Letter size or envelope A4 size

2 Text scale mode Disabled Enabled
3 Page length 11 inches Enabled
4 Character Set Italics 12 inches
5, 6, 7 International

character set
See following descriptions

8, 9, 10 Typeface See following descriptions
11 Printer control

mode
BJ-10 mode Epson LQ

mode
12 Automatic

emulation
switching mode

Disabled Enabled

DIP switch 1
Use this switch to change the horizontal print position according to the size of
your paper. If you are using letter-size paper or envelopes, set this switch OFF;
the left margin will be 0.25 inch (6.4 mm). If you are using A4-size paper or DL-
size envelopes, set this switch ON; the left margin will be 0.13 inch (3.4 mm).

DIP switch 2DIP switch 2
If you are using a software application that assumes 66 lines will fit on each page,
set this switch to ON. The printer will reduce the line spacing by a factor of 14/15,
which is from 62 lines per page to 66 lines per page if line spacing is set ot 6 lines
per inch (lpi).

DIP switch 3DIP switch 3
If you are using letter-size paper, set this switch OFF; this sets the page length to
11 inches. If you are using A4-size paper, set this switch ON; this sets the page
length to 12 inches.

In Epson LQ mode, you use this DIP switch with one-half reduction mode only.

DIP switch 4DIP switch 4
When this switch is OFF, the printer uses the Epson Italics character set, which
includes italic characters. When this switch is ON, the printer uses the Epson
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Graphics character set, which is the same as the MS-DOS code page 437 (this
character set includes sysmbols, lines, corners, and European characters).

To see samples of the character sets available in Epson LQ mode, use Canon's
toll-free fax retrieval system. Call the Canon help desk and request the fax
retrieval system; then request the BJ-200ex Printer Command Summary.

DIP switches 5, 6, 7DIP switches 5, 6, 7
These switches allow you to select one of eight international character sets. These
character sets provide you with the characters and sy\mbols used in other
languages.

DIP switches
Character set 5 6 7
USA OFF OFF OFF
United Kingdom OFF OFF ON
Germany OFF ON OFF
France OFF ON ON
Denmark ON OFF OFF
Sweden ON OFF ON
Italy ON ON OFF
Spain ON ON ON

DIP switches 8, 9, 10DIP switches 8, 9, 10
These switches allow you to select one of eight font typefaces.

DIP switches
Typeface 8 9 10

Roman
OFF
ON
ON

OFF
ON
ON

OFF
OFF
ON

Sans serif OFF OFF ON
Draft OFF ON OFF
Courier OFF ON ON
Prestige ON OFF OFF
Script ON OFF ON
Orator ON ON OFF
Orator-S ON ON ON

DIP switch 11DIP switch 11
When this switch is OFF, the printer is in BJ-10 mode. When this switch is ON,
the printer is in Epson LQ mode.

DIP switch 12DIP switch 12
This switch enables or disables automatic emulations switching mode. (See page
129 for a description.)

Changing a DIP Switch Setting
The DIP switches are located to the left of the operator panel under a small cover.

A DIP switch is OFF when it is up, and ON when it is down. To change a DIP
switch setting, follow these steps:

1. Make sure the printer is turned off.
§ The POWER light should be off.
§ If the power is on now, press the POWER button to turn off the

printer.

2. Open the DIP switch cover on the top of the printer.
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§ Pull the cover toward you lifting from the notch at the top of the cover.
§ You may need to use a thin object, such as a coin, to release the cover.

The cover slides down into the printer.

3. Use a pointed object, such as a ballpoint pen, to change the DIP switch settings.

• A DIP switch is OFF when it is up, and ON when it
down
.

3. Close the DIP switch cover after making your selections.

The new DIP switch settings take effect when you turn on the printer.
If you turn off or reset the printer, or if the printer receives the Set Initial
Conditions command from a software program, the printer resets its functions to
the settings defined by the DIP switches.
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Appendix A
Printer Specifications

This appendix lists the specifications of your printer.

Printing MethodPrinting Method
Bubble jet ink on-demand

Paper HandlingPaper Handling
Automatic feed
Manual feed
Sheet Feeder Capacity
Maximum thickness of stacked paper = 0.39 inch (10 mm)
Plain Paper: Approximately 100 sheets (20 lb or 75 g/m2)
Transparencies: 40 sheets
Envelope: 15 envelopes (U.S. Commercial number 10 or European DL)
Paper Size
Letter: 8.5 x 11 inches
Legal: 8.5 x 14 inches
Ledger: 11 x 17 inches
A4: 210 x 297 mm
B5: 182 x 257 mm
Envelope: 9.5 x 4.1 inches (U.S. Commercial number 10)

220 mm x 110 mm (European DL)

Paper TypePaper Type
Plain paper
Envelopes (Commercial number 10 or European DL)
OHP film / transparency film (Canon #Q07-0001-M1 or 3M CG-3480)

Paper WeightPaper Weight
17 to 24 lb (64 to 90 g/m2) with automatic feed
17 to 28 lb (64 to 105 g/m2) with manual feed

Paper ThicknessPaper Thickness
Less than 0.008 in (0.2 mm)
Printing Speed
HS mode: 248 cps in 10 cpi, 496 cps in 20 cpi
HQ mode: 173 cps in 10 cpi, 346 cps in 20 cpi
SHQ mode: 124 cps in 10 cpi, 248 cps in 20 cpi

Print Width
Maximum 8 in (203.2 mm)

Line Feed SpeedLine Feed Speed
Approximately 100 ms per line at 1/6-inch line in HQ and HS mode

Printing AreaPrinting Area
Paper:
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Horizontal
a = 8.3 to 8.5 in (210 to 216 mm)
b = 0.25 in (6.4 mm) -- Letter-size paper
b = 3.4 mm (0.13 in) -- A4-size paper
Vertical
c = 11 to 14 in (279 to 356 mm)
d = 0.125 in (3.18 mm)
e = 0.3 in (7.6 mm)
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Envelopes:

Horizontal
a = 9.5 in -- Commercial number 10
a = 220 mm for DL size
b = 0.25 in (6.4 mm)
c = 1.24 in -- Commercial number 10
c = 10.4 mm for DL size
Vertical
d = 4.125 in -- Commercial number 10
d = 110 mm for DL size
e = 0.67 in (17 mm)
f = 1.0 in (25.4 mm)

Reduction ModeReduction Mode
U.S. paper sizes:
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European paper sizes:

Resident Printer Control Modes
BJ-10 mode: IBM Proprinter X24E emulation
Epson LQ mode: Epson LQ-510 emulation
Line Feed Pitch
BJ-10 mode: 1/6", 1/8", n/60", n/72", n/180", n/216", and

n/360"
Epson LQ mode: 1/6", 1/8", n/180", and n/360"

(n: programmable)
Printing Characters
Typeface: BJ-10 mode

Prestige and Courier

Epson LQ mode
Roman, Sans serif, Courier, Prestige, Script, Orator, Orator-S,
and Draft
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Pitch: BJ-10 mode
10 cpi, 12 cpi, 17 cpi, and PS

Epson LQ mode
10 cpi, 12 cpi, 15 cpi, 17 cpi, 20 cpi, and PS

Cell
Composition:

36 (h) x 48 (v) dot matrix in HQ mode
18 out of 36 (h) x 48 (v) dot matrix in HS mode

Character Set: BJ-10 mode
IBM Character Sets 1 and 2 and 3 (Code Page 437, 850)

Epson LQ mode
Italics character set and Graphics character set

TrueType
Typefaces

American Text BT, Americana Bold BT, BRoadway BT, Charter
Black BT, Charter Black Italic BT, Charter BT, Charter Italic
BT, Cloister Black Bt, Cooper Black BT, Dom Casual BT,
English 157 BT, Franktur BT, Impress BT, Informal 011 BT,
Poster Bondoni BT, Raleigh Demi bold BT, Schadow Black
Condensed BT, Seagull Heavy BT, Staccato 555 BT, UMBRA
BT

Maximum Number of Characters per LineMaximum Number of Characters per Line
BJ-10 mode
Mode Pitch Characters per line
10 cpi 10 cpi 80 cpl
10 cpi double-wide 5 cpi 40 cpl
10 cpi condensed 17 cpi 136 cpl
10 cpi condensed, double-wide 8.5 cpi 68 cpl
12 cpi 12 cpi 96 cpl
12 cpi double-wide 6 cpi 48 cpl
Proportional spacing PS Varies

Epson LQ mode
Mode Pitch Characters per line
10 cpi 10 cpi 80 cpl
10 cpi double-wide 5 cpi 40 cpl
10 cpi condensed 17 cpi 136 cpl
10 cpi condensed, double-wide 8.5 cpi 68 cpl
12 cpi 12 cpi 96 cpl
12 cpi double-wide 6 cpi 48 cpl
12 cpi condensed 20 cpi 160 cpl
12 cpi condensed, double-wide 10 cpi 80 cpl
15 cpi 15 cpi 120 cpl
15 cpi double-wide 7.5 cpi 60 cpl
Proportional spacing PS Varies
Graphic Image Print
Data format: Vertical 8, 24, and/or 48-dot format
Resolution: Horizontal 60, 120, 180, 240, or 360 dpi, and

720 dpi (720 in Smoothing mode only)
Buffer
BJ-10 mode
Input buffer: 62 KB (or 21 KB)
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Download buffer: 0 KB (or 41 KB)

Epson LQ mode
Input buffer: 23 KB
Download buffer: 39.4 KB

Automatic emulation mode
Input buffer: 21 KB
Download buffer: 41 KB (BJ-10 mode, DIP switch 10 ON)

0 KB (BJ-10 mode, DIP switch 10 OFF)
39.4 KB (Epson LQ mode)

Interface
8-bit
parallel

To receive information regarding the interface specifications, use
Canon's toll-free fax retreival system. Call the Canon fax retrieval
system at 1-800-526-4345; then request the BJ-200ex Interface
Specifications

Ink Cartridge

Type: BC-02 (single cartridge ink supply)
Ink color: Black
Print head: 64 bubble jet nozzles
Number of characters
printed:

Approx. 700,000 characters/cartridge in HQ mode
(5% coverage)
Approx. 1,400,000 characters/cartridge in HS mode

Ink amount: Approx. 0.9 oz (28g)

Acoustic Noise LevelAcoustic Noise Level
Approx. 42 dB(A)
Operating Environment
Temperature: 41º F to 95º F (5º C to 35º C)
Humidity: 10% to 90% RH (no condensation)
Storing Environment
Temperature: 32º F to 95º F (5º C to 35º C)
Humidity: 5% to 95% RH (no condensation)

Power SourcePower Source
USA/Canada AC 120V, 60Hz, 0.5A

Power ConsumptionPower Consumption
7 watts maximum nonprinting
23 watts average printing
30 watts maximum printing

DimensionsDimensions
13.7 in (347 mm) W
7.6 in (193.5 mm) D
6.8 in (173 mm) H

WeightWeight
Approx. 6.6 lb (3.0 kg)
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Appendix B
Application Notes

This appendix contains information on using specific software applications with
your Canon BJ-200ex Bubble Jet Printer. Many popular applications are covered
here. Although the software versions described may not be the latest or may not
be the version you have, these solutions presented may apply to other versions.

The information presented here represents Canon's answers to some frequently
asked questions about using software packages with our printers. The information
is presented in alphabetical order by software application.

Printing Envelopes in Microsoft Windows
AmiPro 3.0

To print envelopes in AmiPro 3.0, follow these steps:

1. From within AmiPro, select the Print envelope icon.
2. Select the number 10 envelope.
3. Click on OPTIONS
4. Click on ADJUST
5. Modify the margins as follows: Right 0.70 and Down 0.35
6. Click on OK to leave The Print Envelope Adjustments window.
7. Click on OK to leave the Print Envelope Options window.
8. Click on OK to print the envelope.

Microsoft Publisher

Method 1

To print envelopes in Microsoft Publisher, follow these steps:
1. Start Microsoft Publisher.
2. Select and run the Envelope Page Wizard design assistant.
3. From the Envelope Page Wizard, select the options you want.
4. After the envelope has been created, delete the text box that says:

TIPS FOR PRINTING YOUR ENVELOPE
5. From the Edit menu, select All.
6. Click the group button to group the objects.
7. From the Edit menu, choose Copy objects.
8. From the File menu, choose New.
9. In the dialog box, select Start from scratch and Full page.
10. When prompted to save your changes, choose NO.
11. In the new document, form the Edit menu choose Paste objects.
12. Drag the group to a position 0.5 inches from the top of the page.
13. On the printer, move the paper selection lever to the envelope position; this is the front

position.
14. On the printer, set the paper thickness lever to the envelope position; this is up.
15. Place the envelope in the sheet feeder (face up and top down).
16. Make sure the printer is on line.
17. In Publisher, form the File Menu choose Page setup.
18. Under Orientation, select Portrait.
19. Under Paper, select Letter 8.5 x 11.
20. From the File menu, choose Print.
21. Click OK.
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Method 2
To print envelopes in Microsoft Publisher, follow these steps:

1. Start the Windows Control Panel.

2. Double click the printers icon.
3. Select the Canon BJ-200ex Bubble Jet Printer.
4. Set up the following options on the printer: Portrait, Envelope, and Manual feed.
5. Choose OK
6. Choose Set as default printer
7. Choose Close
8. Start Microsoft Publisher
9. Select and run the Envelope Page Wizard design assistant.
10. From the Envelope Page Wizard, select the options you want.
11. IMPORTANT: Do not, at any time, choose Print setup form the File menu or form the

Page setup. If you do, the printer driver resets Orientation to Landscape and will not
allow you to change it back. If this happens, you must run the Page Wizard again.

12. On the printer, set the paper selection lever to the envelope position; this is the front
position.

13. On the printer, set the paper thickness lever to the envelope position; this is the right
position.

14. Place the envelope in the sheet feeder (face up and top down).
15. Make sure the printer is on line.
16. From the File menu, choose Print.
17. Click OK

Microsoft Word for Windows
Microsoft Word 6.0 for Windows

To print on envelopes in Microsoft Word 6.0 for Windows, follow these steps:

1. Select tools.
2. Select Envelopes and Labels
3. Click on the feed button
4. In the feed method, select the first envelope from the left
5. Click on the OK button
6. Click on Print

Microsoft Word 2.0 for Windows
If you are using Microsoft Word for Windows, version 2.0 and the Envelope
Macro button in the button bar does not work, follow these steps to print
envelopes correctly. First create the SetPrinterHeuristic dialog box:

1. Start Word for Windows 2.0 (if necessary).

2. From the top menu bar, choose File and then Open.
3. In the Open File dialog box, select Newmacro.doc (in the WINWORD directory) and

choose OK.
4. When the Macro Name dialog box appears, select SetPrinterHeuristic and choose Install.
5. In the Install SetPrinterHeuristic to dialog box, select Normal from the Template list and

then select Tools from the Menu list to place this option in the Tools menu.
6. Choose OK
7. In the top menu bar, choose File and then Close.

The SetPrinterHeuristic menu choice now appears each time you select Tools
from the top menu bar when you are using a normal template. To verify this, open
a new document and select Tools from the menu bar. The SetPrinterHeuristic
choice appears as the last selection of the Tools menu.
To print on envelopes, follow these steps:

1. Type your destination address within your document and then highlight it.

2. In the top menu bar, select Tools and then select SetPrinterHeuristic.
3. In the Envelope orientation box, select the Force Portrait button.
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4. If you are printing multiple envelopes, check on the Avoid Using Device Capabilities for
Paper Sizes box. An X appears in the box. Now choose OK.

The Avoid Using Device Capabilities for Paper Sizes box affects all documents output to
the printer. If you are not printing multiple envelopes, make sure this option is
unchecked.

5. Make sure the printer is ready for printing envelopes.
6. From the button bar, choose the Envelope Macro button. The address appears in the

Destination Address box.
7. Choose the Print button.

WordPerfect
WordPerfect 6.0

If you are using WordPerfect, version 6.0, you need to define your envelope size
using the Envelope Macro Button. Follow these steps:

1. Click on the Envelope Macro.
2. Select Create New Definition.
3. Specify a Paper Name that you will recognize later; for example, BJENV.
4. For Paper Type, select Envelope.
5. For Paper Size, select #10 Env(9.5" x 4.1").
6. For Paper Location, select Autosheet Feeder.
7. For Orientation, disable Rotated Fonts and enable Wide Form.
8. Click on OK to close the Create New Definition box.
9. Enter the Sender and Addressee information and then click the Print button.
10. WordPerfect displays the message: Preparing Document for Printing
11. WordPerfect displays a warning; ignore this warning.

WordPerfect will now print your envelope.
You need not change the Page Layout or any other setting to accommodate
envelopes.
WordPerfect 5.2
If you are using WordPerfect, version 5.2, follow these steps to print envelopes.
First time printing envelopes:
If you are printing envelopes for the first time follow these steps:

1. Choose the Envelope Macro from the Main Screen. If the macro is not displayed, go to
View and then to the Button Bar Setup. Select FEATURES.WWB and follow the steps
for displaying the macro.

2. The first time you choose the Envelope Macro using either the WordPerfect driver or the
Windows driver, a prompt tells you that this paper size does not exist and asks if you
want to add it.

3. Choose Add.
4. Select Portrait orientation and Continuous paper feed. You see the Envelope Editor

screen.
5. Fill in the appropriate mailing address.
6. Make sure the box for Print Envelopes is checked and the Select Envelope Size is 9.5 x

4.12 inches.
7. You can also include a Return Address, change the margin settings, and/or change the

font with which the envelope is printed. For Windows, the default font is a Windows
font. You may want to select a TrueType font or another printer font.

8. After selecting all your options, choose OK. If you are using the Windows driver, you see
this message:

Windows printer driver did not accept the requested paper
size. Document will print on paper size the printer did
select.

9. Choose OK to print the envelope. If you are using the WordPerfect driver, no message
appears and the printer prints the envelope.

Printing envelopes other than the first time:
1. Choose the Envelope Macro from the Main Screen.
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2. If you have set up the envelope size, go to Layout and choose Page.
3. Choose Paper size, Make sure the size is 9.5 x 4.12 inches and the diagram shows the

paper in wide format. If not, choose Edit and make the corrections.
4. Next, you see the Envelope Editor screen. Fill in the appropriate mailing address.
5. Make sure the box for Print Envelopes is checked and the Select Envelopes Size is 9.5 x

4.12 inches.
6. You can also include a Return Address, change the margin settings, and/or change the

font with which the envelope is printed. For Windows, the default font is a Windows
font. You may want to select a TrueType font or another printer font.

7. After selecting all your options, choose OK. If you are using the Windows driver, you see
this message:

Windows printer driver did not accept the requested paper
size. Document will print on paper size the printer did
select.

8. Choose OK to print the envelope. If you are using the WordPerfect driver, no message
appears and the printer prints the envelope.

Works 3.0 for Windows
To print envelopes in Works 3.0 for Windows, follow these steps:

1. Select Tools.
2. Select Envelopes and Labels.
3. Create your Envelope.
4. Go to Page Setup.
5. Click on Source, Size, and Orientation.
6. Click on Reset.
7. Change the Paper Source to Auto Sheet Feeder.
8. Change the Paper Size to #10 Envelope (9.5 x 4.1).
9. Change the Orientation to Portrait.
10. Click on OK.
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